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Customer Support

You can obtain technical support by using the Support page on the BMC Software Web site or by contacting
Customer Support by telephone or e-mail. To expedite your inquiry, please see “Before Contacting BMC
Software.”

Support Web Site

You can obtain technical support from BMC Software 24 hours aday, 7 days aweek at
http://lwww.bmc.com/support.html. From this Web site, you can

*  read overviews about support services and programs that BMC Software offers

»  find the most current information about BMC Software products

»  search adatabase for problems similar to yours and possible solutions

e order or download product documentation

e report aproblem or ask aquestion

»  subscribe to receive e-mail notices when new product versions are released

»  find worldwide BMC Software support center locations and contact information, including e-mail addresses,
fax numbers, and telephone humbers

Support by Telephone or E-mail

In the United States and Canada, if you need technical support and do not have access to the Web, call

800 537 1813. Outside the United States and Canada, please contact your local support center for assistance. To
find telephone and e-mail contact information for the BM C Software support center that services your location,
refer to the Contact Customer Support section of the Support page on the BMC Software Web site at
www.bmc.com/support.html.

Before Contacting BMC Software

Before you contact BMC Software, have the following information avail able so that Customer Support can begin
working on your problem immediately:

e product information

— product name
— product version (release number)
— license number and password (trial or permanent)

e operating system and environment information

— machinetype

— operating system type, version, and service pack or other maintenance level such as PUT or PTF
— system hardware configuration

— seria numbers

— related software (database, application, and communication) including type, version, and service pack or

maintenance level
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sequence of events leading to the problem
commands and options that you used
messages received (and the time and date that you received them)

— product error messages
— messages from the operating system, suchasfi |l e system ful |
— messages from related software
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About This Book

This book contains reference information about installing the PATROL®
product and isintended for system administrators, database
administrators, and al others who install PATROL in their environment.

Note
This book assumes that you are familiar with your host operating system.
You should know how to perform basic actions, such as choosing menu
commands and dragging and dropping icons.

If you are using a Unix system, you should also understand basic Unix
commands such ascd, r m and so forth.
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How This Book Is Organized

This book is organized as follows. In addition, this book contains an

index.

Chapter/Appendix

Description

Chapter 1, “Installation Overview
and Requirements”

provides information about the installation utility and lists
installation requirements

Chapter 2, “Installing Products”

provides information about options for installing products

Chapter 3, “Command Line Options
for Launching the Installation Utility”

provides information about options that you can use when
launching the installation utility from a command line

Chapter 4, “Configuring Products”

provides information for configuring PATROL products after
installation

Chapter 5, “Upgrading to a New
Version of PATROL”

provides procedures for upgrading your previous version of
PATROL to a new version.

You should read this chapter before installing if you are
upgrading your PATROL environment

Chapter 6, “Uninstalling Products”

provides procedures for uninstalling PATROL products

Appendix A, “PATROL Installation
Directories”

describes the PATROL directory structure

Appendix B, “Using PATROL with
Firewalls”

describes how PATROL components communicate across
firewalls

Appendix C, “Troubleshooting”

lists common error messages and solutions

Related Documentation

BMC Software products offer several types of documentation:

e online and printed books
e onlineHelp
* release notes

BMC Software, Inc., Confidential and Proprietary Information
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In addition to this book and the online Help, you can find useful
information in the publications listed in the following table. As“Online
and Printed Books’ on page xv explains, these publications are available
on request from BMC Software.

Category Document

Console documentation PATROL Console for Microsoft Windows User Guide
Understanding the Basics of PATROL Volume 1

PATROL Console for Microsoft Windows User Guide
Monitoring and Managing with PATROL Volume 2

PATROL Console for Microsoft Windows User Guide
Customizing PATROL Volume 3

PATROL Console for Unix User Guide

PATROL Central Operator — Microsoft Windows Edition
Getting Started

PATROL Central Operator — Web Edition Getting Started

Agent documentation PATROL Agent Reference Manual

Product getting started guides See the documentation for the specific products that you
want to install

Online and Printed Books

The books that accompany BM C Software products are available in
online and printed formats. Online books are formatted as Portable
Document Format (PDF) files. Some online books are also formatted as
HTML files.

To Access Online Books

To view any online book that BM C Software offers, visit the Customer
Support page of the BMC Software Web site at
http://www.bmc.com/support.html. You can also access PDF books from
the documentation compact disc (CD) that accompanies your product.
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Use the free Acrobat Reader from Adobe Systems to view, print, or copy
PDF files. In some cases, installing the Acrobat Reader and downl oading
the online books is an optional part of the product-installation process.
For information about downloading the free reader from the Web, go to
the Adobe Systems site at http://www.adobe.com.

To Request Additional Printed Books

BMC Software provides some printed books with your product order. To
request additional books, go to http://www.bmc.com/support.html.

Online Help

You can access Help for a product through the product’s Help menu. You
can access Help for the installation utility from the Help buttons on each
window in the utility. The Help provides information about the product’s
graphical user interface (GUI) and provides instructions for completing
tasks.

Release Notes

Printed release notes accompany each BMC Software product. Release
notes provide up-to-date information such as

e updatesto theingtallation instructions
e last-minute product information

The latest versions of the release notes are a so available on the Web at
http://www.bmc.com/support.html.
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Conventions

The following conventions are used in this book:

e Thisbook includes specia elements called notes, warnings,
examples, and tips:

Note
Notes provide additional information about the current subject.

Warning
Warnings alert you to situations that can cause problems, such as loss of
data, if you do not follow instructions carefully.

Example
An example clarifies a concept discussed in text.

Tip
Tips contain information that might improve product performance or that
might make procedures easier to follow.

« Al syntax, operating systemterms, and
literal exanples are presented in this
t ypef ace.

* Ininstructions, boldface type highlights information that you enter.
File names, directories, Web addresses, e-mail addresses, and names
of GUI elements also appear in boldface type.

e The symbol => connects items in a menu sequence. For example,
Actions => Create Test instructs you to choose the Create Test
command from the Actions menu.

e Thesymbol > denotes one-step instructions.

BMC Software, Inc., Confidential and Proprietary Information
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* Insyntax, path names, or system messages, italic text represents a
variable, as shown in the following examples:

The tabl e tabl eNanme is not avail abl e.
system/instance/fileName
* Insyntax, the following additional conventions apply:
— A vertical bar (|) separating items indicates that you must
choose one item. In the following example, you would choose a,
b, or c:
al b|] c

— Andlipsis(...) indicates that you can repeat the preceding
item or items as many times as necessary.

— Square brackets ([ ] ) around an item indicate that theitem is
optional.

BMC Software, Inc., Confidential and Proprietary Information
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Installation Overview and
Requirements

This chapter provides information about the installation utility and lists
installation requirements. It contains the following topics:

About the Installation Utility .. ........... ... ... ... .. .... 1-2
Checking Installation Requirements. . .. ...................... 1-2
Hardware and Operating System Requirements .. ........... 1-2
Memory and Disk Space Requirements. . .................. 1-8
Network Requirements . .......... ..., 1-8
Changing the Default Installation Values. . .................... 1-10
Installation Typesfor Local Installations. . .................... 1-10
Remote Installations Using Installable Images .. ............... 1-11
Setting Up An Installation Account . .. ... n... 1-12
PATROL Installation Account for Windows Environments . . . . 1-12
PATROL Installation Account for Unix Environments. . . ... .. 1-16
Gathering Product Configuration Information. .. ............... 1-17
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About the Installation Utility

By using the BMC Software installation utility, you can perform alocal
installation or uninstallation of BM C Software products on computers
running Windows or Unix operating systems. The installation utility also
provides an option so you can create a product image that can be
transferred to and installed locally on remote computers (remote
installation functionality).

Checking Installation Requirements

When you plan an installation of BMC Software products, you must
consider whether limitations or restrictions exist in your environment.

Before you launch the installation utility, ensure that your environment
meets the hardware and software requirements described in the following
sections. Also, before you install any product to your environment,
consult the product getting started guides and release notes for the
reguirements for each product that you want to install and for detailed
installation information.

Hardware and Operating System Requirements

Windows

The following sections describe the hardware and operating system
requirements for both Windows and Unix environments and the
supported Web browsers for the installation utility.

To run the installation utility in your Windows environment, your
operating system must be one of the following types:

e Windows 2000 Server, Service Pack 2 or 3 (Intel)

*  Windows 2000 Server with Citrix M etaframe, Service Pack 2 or 3
* Windows 2000 Datacenter Server, Service Pack 2 or 3

e Windows NT 4.0, Service Pack 6A (Intel)

BMC Software, Inc., Confidential and Proprietary Information
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e Windows NT 4.0, Enterprise Edition, Service Pack 6A (Intel)

*  Windows XP Professional

¢ Windows 2000 Professional, Service Pack 2 or 3

* Windows 2000 Advanced Server, Service Pack 2 or 3

e Windows .NET, Standard Server, Enterprise Server, and DataCenter
Server, Beta 3 release up to build 3628

On .NET platforms, the installation utility must be run from a
command line using the -serveronly command line option. For more
information on -serveronly, see Chapter 3, “Command Line Options
for Launching the Installation Utility.”

Note
In accordance with BMC Software's support policy, BMC Software plans
to provide toleration support for the .NET Server product line after it is
released by Microsoft. Towards that end, this release of the installation
utility has passed testing with the Beta 3 release of the .NET Server
product line up to build 3628. However, the installation utility should not
be used with .NET Server in a production environment at thistime.
Customer support requests related to the NET Server product line will be
considered on a case-by-case basis.

The hardware requirements include

* aCD-ROM drive (or network access to a CD-ROM product image)

e aFAT or NTFSfile system (HPFS is not supported)

e a256-color display environment on any computer where you want to
install products

BMC Software, Inc., Confidential and Proprietary Information
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Unix

BMC Software, Inc., Confidential and Proprietary Information

The CPU and operating system requirements for the installation utility
for Unix are shown in Table 1-1.

Table 1-1  CPU and Operating System Version Requirements for Unix
(Part 1 of 2)
Operating Supported
CPU System Versions Comments
DEC Alpha Tru64 Unix 4.0F, 4.0G,
5.0A, 5.1,
5.1A
HP 9000/700 HP-UX 10.20
HP 9000/700 HP-UX 11.0, 11i 32-bit; 11i is 32-bit RISC
(B.11.11)
HP 9000/800 HP-UX 11.0, 11i 64-bit; 11i is 64-bit RISC
(B.11.11)
IBM RS/6000 AIX 4.3.2,4.3.3, | 32-bit; 5.1 is 32-bit RISC
5.1,5.2
IBM RS/6000 AlX 4.3.2,4.3.3, | 64-bit; 5.1 is 64-bit RISC
5.1,5.2
Sun SPARC Solaris 2.5.1,2.6,7, | 32-bit; 2.5.1 not
8,9 supported on
international platforms
Sun SPARC Solaris 7,8,9 64-bit
Siemens Nixdorf SINIX/Reliant 5.4.3,5.4.4, | 64-bit
Unix 5.45
Intel Red Hat Linux 6.1,6.2,7.0, | 6.1 not supported on
7.1,7.2,7.3, | international platforms
Advanced
Server 2.1
IBM zSeries Red Hat Linux | 7.2 31-bit
Intel DYNIX ptx 452,46.1 i386; not supported on
international platforms
Intel SuSE Linux 6.3,6.4,7.0, | i386
7.1,7.2,7.3,
8.0

1-4
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Table 1-1

CPU and Operating System Version Requirements for Unix

(Part 2 of 2)

Operating Supported
CPU System Versions Comments
IBM zSeries SuSE Linux Enterprise 7.0 is 31-hit only;
Server 7.0, 7.2 is 31-bit and 64-bit
7.2
Intel Linux for s/390

Web Browser

The following Web browsers are supported by the installation utility:

e Microsoft Internet Explorer version 5.0, 5.5, and 6.0 for Windows
platforms only (version 5.0 and 5.5 are not supported on Windows

XPand

NET)

« Netscape version 4.75 through 4.78 for English and international
platforms and the following versions for specific international
platforms:

« version 4.7 for Japanese platforms running Solaris 2.6, 7, and 8

e version 4.72 for Japanese platforms running Red Hat Linux 6.2

and

7.1

» version 4.73 for Korean platforms running Red Hat Linux 6.2,

7.0,

and 7.1

e version 4.78 for al international platforms running Red Hat
Linux 7.2

Note

You must have Java Script enabled in Netscape.

Note

You cannot run the installation utility if your browser is set to high
security mode.
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Defining Proxy Servers

If you have defined a proxy server for internet connections, your browser
may be unable to connect to the Perl Web server that is used by the
installation utility. You can either remove the proxy connection setting
and close the browser before running the installation utility, or you can
bypass the proxy connection setting by performing the following task for
your browser:

« Internet Explorer: In the browser window, select Tools=> Internet
Options=> Connectionstab => L AN Settings => Bypass proxy server
for local addresses.

* Netscape: In the browser window, select Edit => Preferences =>
Advanced => Proxies => Manual Proxy Configuration => View and
enter your domain in the Exceptions field.

Displaying Installation Utility Online Help

Theinstallation utility includes a browser-based online Help system that
can be accessed from the Help button on each window in the utility. To
properly display the online Help

» the Web browser that you are using to run the installation utility must
be Java-enabled

e you must have a Java virtual machine or Java Plug-in version 1.1.2 or
later installed

» thejavad0,jar file must exist in your Netscape installation directory

If it does not exist, you must download and reinstall Netscape.

BMC Software, Inc., Confidential and Proprietary Information
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e on Unix computers, the variable MOZILLA_HOME should be set to
point to the root of the Netscape installation directory

Example
For sh or ksh users, if the Netscape installation directory is /opt/netscape,
enter the following commands to set this variable:

MOZILLA_HOM E=/opt/netscape
export MOZILLA_HOME

Example
For csh users, if the Netscape installation directory is /opt/netscape, enter
the following command to set this variable:

setenv MOZILLA_HOME /opt/netscape

Setting Font Size

If the font sizein your browser istoo large or too small, you can adjust
the size as shown below.

Microsoft I nternet Explorer
Choose View => Text Size and then one of the options that appears in the

drop-down menu, Largest, Larger, Medium, Smaller, or Smallest.
Experiment to see which size is most comfortable for you.

Netscape

Choose View => I ncrease Font Size or View => Decrease Font Size. You
can adjust the font size until it is comfortable for you.
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Memory and Disk Space Requirements

Check the memory and disk space requirements listed in the getting
started guide for your products to determine the amount of disk space
you will need to install each component on each computer. The
installation utility also provides an estimate of how much disk spaceis
required for al products that you select to install.

Network Requirements

For both Windows and Unix platforms, you must have a properly
installed TCP/IP local area network.

Warning

Theinstallation utility provides a command line option called -serveronly
that you can use to start a Web server on one computer and connect to
that server across a network from a browser running on another
computer. The installation utility uses standard, unsecured HTTP for
network communications, which can create security risks for passwords
and other information that you may want to be secured across network
traffic. Therefore, BMC Software recommends that you install locally or
create an installable image to distribute to remote systems rather than use
the -serveronly command line option in an unsecured network. For more
information on command line options, see Chapter 3, “Command Line
Options for Launching the Installation Utility.”

Windows Network Requirements

If you areinstalling PATROL in a Windows environment, the PATROL
Agent requires the following provisions regarding | P addresses:

« The PATROL Agent must be able to obtain an | P address using the
get host bynane library call during startup.

* You should not change the I P address while the PATROL Agent is
running.

BMC Software, Inc., Confidential and Proprietary Information
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If the Dynamic Host Configuration Protocol (DHCP) does not change the
I P address when the |ease expires, then the PATROL Agent for Windows
supports computers that are configured for the DHCP. An IP address
change could result in the console losing connectivity with the PATROL
Agent. Thisloss of connectivity will not affect any other applications that
may be running on the same compulter.

If you experience aloss of connectivity between the console and agent, to
reconnect, the standard TCP/IP must be able to produce the current IP
address of the agent machine. Then, you must restart the PATROL Agent
to bind the TCP sockets to the | P address for proper communication with
the console.

Unix Network Requirements

Both ftp and telnet must be enabled on the computers on which you want
toinstall PATROL.

BMC Software recommends that you install PATROL on local partitions,
not on NFS-mounted partitions. You can send product packages to
NFS-mounted partitions for local installation on those computers.

Note
If you doinstall PATROL on NFS-mounted partitions, the root account

must have been granted root access privileges on the NFS server.
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Changing the Default Installation Values

Theinstallation utility installs PATROL products by using default values,
unless you choose to change them in the installation utility.

If you are performing an over-the-top installation and you used different
values when you installed the previous version of PATROL, you must
change the default values to match those used in your previous
environment so that you can install the new PATROL Agent and
PATROL Classic Console in the same location as the previous versions.

Note

In an over-the-top installation, the customizations you have made to the
previous versions of the agent and console are automatically preserved.
For more information, see “ Over-the-Top Installation” on page 5-7.

Installation Types for Local Installations

For most BMC Software products, you can choose between a Typical or
Custom installation path to install products. By using the Typical path,
you can select only product groups, and enter only mandatory product
configuration information. By using the Custom path, you can select
product groups, and then select or deselect individual products or
components within a group. The Custom path also requires you to enter
mandatory product configuration information, but also allows you to
enter optional product configuration information.

For more information, see “Options for Selecting Productsto Install” on
page 2-8.
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Remote Installations Using Installable Images

If you want to install products to more than one computer, you can use
the installation utility to create an installable image of products,
distribute that image to remote computers, then use the image to install
the products on the computers to which the image was distributed.

You can distribute the image in several ways.

« tar theimage and use ftp or secure ftp to send it to the remote
computers

e useathird-party distribution system such as Microsoft Systems
Management Server (SMS)

e burntheimageto a CD and distribute the CD
e place the image on a shared network drive

If you choose this option, make sure that the image's control file (.ctl)
is read-only before placing the image on the drive so that thefileis
not deleted after the first installation. The control file stores the
information that you enter in the installation utility, such as
installation directory and any product configuration information. The
installation engine uses the information stored in the control fileto
install the products in the location and with the configuration that

you specify.

When you create an installable image, the product configuration
information that you enter, such asinstallation directory, account names,
passwords, and so forth, must be the same for al computers on which the
imageisinstaled. If you want to specify different settings for different
computers, you must do one of two things:

« edit the variables in the image's contral file by using the ctltool
e create a separate image for each set of values that you want to
implement

For more information, see “ Creating, Distributing, and Installing
Installable Images’ on page 2-13.
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Setting Up An Installation Account

This section describes how to set up a PATROL installation account for
Windows and Unix platforms.

PATROL Installation Account for Windows Environments

PATROL requires a dedicated user account in the Windows environment
known as the PATROL default account. The PATROL default account
must be created before you install PATROL. The PATROL default
account can be alocal or a domain account.

Stand-alone workgroup servers must use alocal user account asa
PATROL default account. Serversthat are trusted members of a domain
may use either alocal or domain account. In each case, the PATROL
default account must be a member of the local Administrators group of
the computer where the agent will reside.

PATROL default accounts on domain controllers should be only domain
accounts. The account on a domain controller must be a member of the
domain Administrators group.

Although you can use an existing Windows user account, BMC Software
recommends that you create a separate Windows user account for
PATROL.

Do not use a domain or local Administrator account as the PATROL
default account. Such account usage causes files created by PATROL to
be owned by the Administrator, which could result in security or file
access problems.

The PATROL Agent uses the default PATROL account for rightsto
perform the following advanced functions:

e collect information from performance counters
e collect information from the Windows event log

e self-tunefor peak performance and nonintrusive use of the processor
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e access system-level information

« make debug-level output available from the PATROL KM

applications

e access the command interpreter for operating-system-level

commands

e create and remove processes in the process table for collecting

performance data

To enable the PATROL Agent to perform advanced functions, the
PATROL default account must be granted the following advanced user
rights. The ingtallation utility automatically grants these rightsto the

default account:

Table 1-2

Advanced User Rights

Account Rights

PATROL Agent Dependencies

Act as part of operating
system

enables PATROL to perform as a secure, trusted
part of the operating system

Debug programs

enables PATROL to debug low-level objects

Increase quotas

enables PATROL to increase object quotas

Log on as a service

allows the PATROL Agent to be started as a service
so that it will start on system boot

Log on locally

allows PATROL to log on at the computer

Profile system
performance

enables PATROL to use the profiling capabilities of
Windows

Replace a process level
token

enables PATROL to modify a security access token
for a process

PATROL APIs and Required User Rights

The following APIsthat PATROL uses require certain advanced user
rights. Table 1-3 shows the API and the advanced right that it uses.
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Table 1-3  APIs and User Rights

API Advanced User Right

LogonUser « Act as part of operating system
* Log on locally

TerminateProcess Debug programs

CreateProcessAsUser * Replace process-level token
* Increase quotas

OpenSCManager Log on as a service

PATROL Default Account as a Local User Accountt

You can create alocal or domain user account if you are installing
PATROL on alocal server. The user account that you create will be used
asthe PATROL default account. The account must be a member of the
local Administrators group.

Theinstallation utility automatically grants the required advanced user
rightsto the PATROL default account during PATROL installation. If you
would like to grant the advanced user rights before PATROL installation,
you can grant them on the local server.

PATROL Default Account as a Domain User Account

You must create adomain administrator user account if you want to use a
PATROL default account that resides on the domain level instead of on
the local level. The PATROL default account must be a member of the
Domain Administrator group. The Domain Administrator group or
PATROL default account must also be a member of the local
Administrators group of the server where you are installing or running
the PATROL products.

During installation, the installation utility automatically grantsthe
required advanced user rights to the PATROL default account on the
server that contains the PATROL products. If you would like to grant the
advanced user rights before PATROL installation, you can grant them on
the server where you are installing or running the PATROL products.
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Creating the PATROL Default Account

This section describes how to create the following accounts for Windows
environments:

* |oca PATROL default account
* domain PATROL default account

Note
Be sure that no PATROL default accounts exist with the same name on
the domain and the local level.

Windows NT

To create alocal PATROL default account, use the User M anager for
Domain utility on thelocal server. Add thelocal PATROL default account
into the local Administrator group and select the User Cannot Change
Password and the Password Never Expires optionsin the dialog box.

To create adomain PATROL default account, use the User Manager for
Domain utility at the domain level. Add the domain PATROL default
account into the Domain Administrator group and select the User Cannot
Change Password and the Password Never Expiresoptionsin the dialog
box.

Windows 2000

To create alocal PATROL default account, use the Computer
Management snap-in on the local server. Add the local PATROL default
account into the local Administrator group and select the User Cannot
Change Password and the Password Never Expires optionsin the dialog
box.

To create adomain PATROL default account, use the Active Directory
Users and Computers snap-in at the domain level. Add the domain
PATROL default account into the Domain Administrator group and select
the User Cannot Change Password and the Password Never Expires
options in the dialog box.
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Using a Local Account for Installation

To install products, log on to the local server with the local user account
that you created that is a member of the local Administrator group. You
will also enter the name of this account when you are prompted for the
default account.

After you finish installing, you must log off and log back on to your
computer so that the seven user rights shown in Table 1-2, “Advanced
User Rights,” on page 1-13 will take effect. You do not need to reboot
your machine unlessit is specifically required by one of the products that
you have installed on your computer.

PATROL Installation Account for Unix Environments

BMC Software recommends that the Unix account that you create meets
the following conditions:

» Theaccount .login, .profile, .cshrc, and .kshrc files should contain as
little user customization as possible. Specifically, they should have
no aliases, the prompt should be set to the default, and they should
have no command to change the umask setting. The recommended
umask setting for the installation account is 022.

e Do not useroot to install PATROL products as this may create
security risks.

« Besure the account has permission to create directoriesin the
directory where you will install PATROL products.

e The computers on which you want to install PATROL must have ftp
and telnet enabled.

« PATROL configuration requires privileges usually reserved by the
system administrator. These privileges include accessto aroot
account on the hardware where you want to install PATROL.
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*  BMC Software recommends that you install PATROL on local
partitions, not on NFS-mounted partitions. If you do install PATROL
on NFS-mounted partitions, the root account must have root access
privileges on the NFS server.

e Theaccount that you use to install PATROL must have permission to
write the installation logs to the SHOME and /tmp directories on the
computer where you are installing products.

Gathering Product Configuration Information

To install products, you will be asked to enter product configuration
information in the installation utility for the products that you are
installing. The type and amount of information depends on the products
that you are installing and the type of installation that you are performing
(Typical or Custom). Consult the product getting started guides and
release notes for details on the information that you must enter for each
product that you are installing.
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Installing Products

This chapter describes options for installing products. It includes the
following topics:

BeforeYoulngtal. ... ... .. ... 2-3
Before You Begin Installing to a Windows Computer. . .. ... .. 2-3
Before You Begin Installingto aUnix Computer . ........... 2-4

Installing Productsfor the First Time. .. ...................... 2-5
Installation Workflow for First Time Installation ............ 2-5
Installation Checklist for First Time Installation. . ........... 2-6

Options for Starting the Installation Utility .................... 2-7
Starting the Installation Utility on Windows Platforms. . ... ... 2-7
Starting the Installation Utility on Unix Platforms .. ......... 2-7

Optionsfor Installing Products. . ............................ 2-8

Options for Selecting ProductstoInstall .. .................... 2-8

Selecting Products By Using the Typical Installation Path . . . . . 2-8
Sdlecting Products By Using the Custom Installation Path. . . . . 2-9

Sdlecting Security Levels. .. ... o 2-11
Creating, Distributing, and Installing Installable Images. . . ... .. .. 2-13
Installable Image Filesand Directories. .. ................. 2-13
Account Requirements for Creating an Installable Image on
WindowsPlatforms. .. ........ . i 2-14
Creating an Installable Image of Products. ................. 2-15
Deploying the Installable Image to Your Environment . .. ... .. 2-16
Installing an Image on aWindows Computer ............... 2-18
Installing an ImageonaUnix Computer. . ................. 2-20
Editing Control Filesfor Installablelmages . ............... 2-21
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Using the ctltool to Edit Control Filesfor Installable Imagesin

Windows Environments . ............ .. i 2-23
Using the ctltool to Edit Control Filesfor Installable Imagesin
Unix Environments. . ... 2-25
Performing aMultiple CD Installation. ... .................... 2-26
LocatingLogFiles .......... i i 2-27
Location of WindowsLogFiles. ......................... 2-27
Locationof Unix LogFiles ............................. 2-28
Installing an Agent or Console Patch to Your Environment. . . ... .. 2-28
Accessing the BMC Software Support Web Site............. 2-28
DownloadingthePatch. ................................ 2-29
InstallingthePatch............. ... ... ... ... .. ........ 2-32
Patch Issueswiththe PATROL KMDS . ................... 2-32
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Before You Install

The following sections describe activities you should perform before you
install any products to your environment.

Before You Begin Installing to a Windows Computer

Complete the following tasks before you install to Windows platforms.

e Close all open applications on the computer where you are running
the installation utility.

e |If you areinstalling on a computer that is running Windows Terminal
Services, make sure that the check.exe file existsin the
Windows\System32 directory. The installation utility usesthisfileto
install productsin a Terminal Services environment. If the file does
not exist, you will need to copy it from another Terminal Services
computer.

» Review the procedure in the next section if you are installing
products on a backup domain controller.

Tip
If you will be using Netscape 4.78, set the priority to low so that the
installation utility will run more efficiently.

Before you Install on a Backup Domain Controller

Note
Installing on a backup domain controller applies only to WindowsNT 4.0
environments.

If you are installing products on a backup domain controller (BDC)
without first installing to the primary domain controller (PDC) inasingle
domain, you must perform the following procedure before you install the
products.
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Step 1

Step 2

Step 3

From the User Manager for Domains, create a default account.

Assign the required advanced user rights to the default account. See
Table 1-2, “Advanced User Rights,” on page 1-13.

Synchronize the entire domain. This process updates all the BDCsin the
domain with the updated user account database.

Once you have completed this procedure, you can install products on a
BDC using the account that you created.

Before You Begin Installing to a Unix Computer

Complete the following tasks before you install to Unix platforms.
* Mount the CD-ROM.
e Set the umask setting to 022.

e Set the DISPLAY environment variable so that the GUI interface will
be displayed properly on your system.

» Beforeyouinstall products, you must disable any profiles that affect
the login and root accounts. The installation and root accounts should
have a*“clean” login meaning that the login should be free of any
special processing before a shell prompt is displayed.

Tip
The preferred login shell isaBourne shell. A Korn shell or aC shell is
acceptable, but, on rare occasions, may cause intermittent problems
during the installation; for example, the installation utility may be unable
to access the root account to perform the installation.
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Installing Products for the First Time

This section provides an installation workflow and checklist for installing
PATROL products for the first time. For step-by-step installation
instructions, see the getting started guides for the products that you are

installing.
Installation Workflow for First Time Installation

The following workflow shows the process for installing PATROL
products for the first time.

Prepare to install.

Locate the products
that you want to
install.

v

Gather and read the
product
documentation from
the Kits.

Set up the PATROL
default account.

v

Determine the base
product installation
directory location for
the installed products.

v

Install locally.

Determine the role of
each computer on
which you want to

install products.

Install products to the
local computer.

v

Determine the type of
installation you want
to perform.

OR

v

Create an
installable image.

Determine the level of
security that you want
to use.

Create an installable
product image to be

Configure products.

installed on other

computers.
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Start the console.

v

Add managed
systems.

v

Load KMs.

Configure agents to
preload KMs and
disable KMs (as

needed).

:| = required step

_____
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Installation Checklist for First Time Installation

Before you install products for the first time, use the checklist below to
determineif you have al of the information you need.

e Account requirements have been met for Unix or Windows platform.

e A separate user account has been created to use as the default
account for PATROL Agent. (A separate account is recommended
but not required. You can use the same account to install PATROL
and as the PATROL default.)

e TCP/IP protocol is used for data transfer across network.

* You have alist of products to be installed on each compuiter.

e You have reviewed system requirements for all products you plan to
install.

» All target computers have enough disk space and RAM.

» All target computers running an RDBM S have enough semaphores
and shared memory for both the RDBM S and PATROL..

e All target computers are running supported versions of the OS and
other applications used with PATROL..

« All target computers have a similar directory structure so you can
specify asingle path for the location where PATROL products will be
installed.
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Options for Starting the Installation Utility

You can launch the installation utility from a command line and specify
certain command line options to access additional functionality. For
details on command line options, see Chapter 3, “Command Line
Options for Launching the Installation Utility.”

Starting the Installation Utility on Windows Platforms

»> Perform one of the following tasks:

e UseWindows Explorer to open the CD directory and double-click
setup.exe. (Do thisonly if you do not want to specify any special
command line options.)

e Open aDOS command window and change to the
<CD-ROM_drive>:\setup.exe directory. Type setup.exe at the prompt
and any other command line options you would like to include (if
any), then press Enter.

Starting the Installation Utility on Unix Platforms

>> Mount the CD-ROM and type ./setup.sh at the root of the CD.

Note
On Unix systems, you cannot g ect removable mediawhile the mediais
being accessed; therefore, if your installation requires multiple product
images and you are using removable media, then from a command line,
cd to/ and launch the installation utility by specifying the absolute path;
for example, /mnt/cdrom/setup.sh.
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Options for Installing Products

You can install products on the computer on which you are running the
installation utility, or you can create an installable image of products that
can beinstalled at alater time. For detailed instructions on how to install
PATROL products, see the getting started guides for the products that you
areinstalling. For detailed instructions on how to create an installable
image, see “Creating, Distributing, and Installing Installable Images” on
page 2-13.

Options for Selecting Products to Install

Thelist of productsthat you can select to install is based on the
installation type and, optionally, on a system role that you select. Some
products do not require different installation types or system roles. If this
isthe case for the product that you are installing, the Select Type of
Installation and the Select System Role windows are not displayed in the
installation utility. The following sections describe installing a product
that uses two installation types.

Selecting Products By Using the Typical Installation Path

If you select the Typical installation path, you will see a product selection
tree similar to the one shown in Figure 2-1.

Figure 2-1 Example of a Product Selection Tree View for PATROL
Products—Typical Installation Path

@ Product Selection
El'a PATROL Solutions for Microsoft Windows - QuickStart Packages

@ " Manage Microsoft Cluster Server (Do nat install on Cluster Nade)

@ " Manage Microsoft Cluster Server (Install an Cluster Made anly)

@ " Manage Microsoft Host Integration Server
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The only selectable options shown are product solutions or groups, which
are comprehensive sets of products designed to work together. If you are
installing products using the Typical installation path, you can select only
comprehensive solutions or groups from the product selection tree. When
you select a solution or group, al of the products included in that product
set are automatically selected; you may not be able to deselect individual
products that you do not want to install if you use the Typical path.

In addition, you are presented with subsequent windows to enter only
mandatory product configuration information.

Use the Typical installation path if your installation scenario is similar to
one of the following examples:

e Youareinstalling products for the first time.

e Youwould liketo use default values for most product configuration
information.

* You want to select a prepackaged group of products with predefined
configurations.

e You are not familiar with the product set that you are installing.

Selecting Products By Using the Custom Installation Path

If you select the Custom installation path, you will see a product
selection tree similar to the one shown in Figure 2-2 on page 2-10.
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Figure 2-2 Example of a Product Selection Tree View for PATROL
Products—Custom Installation Path

_ﬁ Product Selection

=i FATROL Solutions for Microsoft Windows

Click this
check box...

~&l T PATROL for Microsoft Host Integration Server

—H*&F PATROL for Microsoft Windows Servers

¥ Microsoft Wil Core Components for NT 4 SP4 or greater.
¥ PATROL Adapter for Microsoft Office

¥ PATROL Adapter far WEEM

¥ PATROL Agent for Microsoft Windows Servers

W PATROL Cluster Configuration Wyizard

W PATROL Configuration Toal

¥ PATROL Consale for Microsaft Windows

ST

and all products that belong to the specified
solution are automatically selected.

If you are installing products using the Custom installation path, you will
see solutions or groups and individual products. When you select a
solution or group, al of the products that belong to that product set
(including required and optional products) are automatically selected. By
using the Custom installation path, you can deselect any of the optional
products that you do not want to install.

In addition, you are presented with subsequent windows to enter both
mandatory and optional product configuration information about these
products.

Use the Custom installation path if your installation scenario is similar to
one of the following examples:

* You are upgrading a previous product installation (you can aso use
the Custom path if you are installing a product for the first time).

« Youwould liketo select and deselect products within product groups.
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e You want to more fully customize your product configuration.

e You are familiar with the product set that you are installing.

Selecting Security Levels

Security is easily employed in your environment by using predefined sets
of security configurations. You sdlect the security level when you install
PATROL. PATROL employs a security system that protects your
environment at your discretion and prepares you for security risks that
might be inherent in your environment.

Thisversion of PATROL provides five standard levels of security. Basic
security (the default) isthe lowest level of security. Advanced security
(levels 1 through 4) provide increasingly higher levels of security, along
with increasingly greater configuration demands. For more information,
see the PATROL Security User Guide.

Note
If you plan on installing advanced security, BM C Software strongly
recommends that you thoroughly review the contents of the PATROL
Security User Guide for information about the configuration
reguirements of each security level.

If aproduct you select has specific security requirements, a security
window is displayed during the installation. You can set the required
level of security for the indicated product. See Table 2-1, on page 2-12
for an overview of all of the security levels.
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Table 2-1 Product Security Levels

Security Level

Description

Basic security

« default level of security employed when you

install PATROL

no cryptographic protection of network traffic

no verification of product or data integrity
authentication provided and protected password
stored in unattended operations in the PATROL
application

minimized security and access control lists
(ACLs) in favor of usability and performance

Level 1

Diffie-Hellman used for privacy
no SSL authentication of either party to the other

Level 2

private communications provided by SSL

no SSL authentication performed (console runs
in keyless mode)

defaults to unattended agent restart

Level 3

private communications and server
authentication provided by SSL

certificate provided by agent so that the console
can authenticate the agent

console not authenticated back to the agent

defaults to unattended agent restart; can
configure for attended agent restart

Level 4

private communications and mutual
authentication of the console and the agent
provided by SSL

defaults to unattended agent restart; can
configure for attended agent restart

Warning

For the PATROL Performance Assurance® products, selecting any
advanced security level above the basic security level will disable
network communication between the PATROL Performance Manager

and the Perform agent.
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Creating, Distributing, and Installing Installable
Images

This section describes creating, distributing, and installing product
images.

Installable Image Files and Directories

The installable image consists of the following files and directories.

You will use or refer to the following files when you launch the
installation utility from an installable image.

e install.exe (Windows) or install.sh (Unix)—run this executable or
script from a command line to install the products in theimage on a
local computer.

e *ctl—this control file saves all of the installation and product
configuration information that you entered when you created the
image.

Warning
If you want to install the same image to more than one computer, you
must change the file permissions on the contral file to read-only so that
thefileis not erased after the first installation.

« *.log—when the ingtallation is complete, log files are created in the
directory from which you installed the image.

Theinstallation utility uses information stored in the following
directoriestoinstall the image.

e Products—this directory contains subdirectories that store the

product files needed by the installation utility to install the products
that are part of the image.
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e Install—this directory contains two subdirectories, instbin, which
stores the install ation engine binaries and install ation tools such as
ctltool, and instdata, which stores the default text files that control
the order in which the products are installed and that list the
operating systemsthat are recognized by the installation utility.

Account Requirements for Creating an Installable Image on
Windows Platforms

To create an installable image on Windows platforms, you must be a
member of the local Administrator group on the computer on which you
are creating the image. To install the image, the person performing the
installation must be a member of the local Administrator group on the
computer on which theimage is installed.
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Creating an Installable Image of Products

Summary:

Step 1
Step 2

Step 3

Step 4

This procedure describes how to create a product image on alocal
computer for local installation on other computers. It applies to both
Windows and Unix platforms.

Start the installation utility.
Review the license agreement and select Accept.

On the Select I nstallation Option window, select | want to create an
installableimageto beinstalled later and enter the name of a directory on
your computer where you would like to save the image.

Proceed through the installation as you would if you were installing
products locally, entering all required product configuration values.

Note
When you create an installable image, the product configuration
information that you enter, such as product installation directory, account
names, passwords, and so forth, must be the same for all computers on
which theimage isinstalled. If you want to specify different product
configuration values for different computers, you must either create a
separate image for each set of values that you want to implement or use
the ctltool to change variables stored in the image's control file after the
image is generated. For more information on using the ctltool, see
“Editing Control Files for Installable Images’ on page 2-21.
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Step 5

On the Review Selections and Create | mage window, click Create I mage.

Note
To create an installable image that you can install on multiple Windows
or Unix operating systems, you must launch the installation utility from a
command line and use the -repository_odist command line option to
specify the operating systems on which you want the imageto install.
You can also use the -repository_oslist option to create an image on a
Windows computer to be installed on Unix computers or create an image
on a Unix computer to be installed on Windows computers. For more
details, see “Command Line Options for Windows Platforms’ on page
3-2 or “Command Line Options for Unix Platforms’ on page 3-16.

Note
You cannot create an installable image that can be installed on both
Windows and Unix computers. You must create one image for all
Windows operating systems and one image for al Unix operating
systems; however, you can create either image from a Windows or Unix
computer.

Deploying the Installable Image to Your Environment

Once you have created an installable product image, you can deploy it to
your environment for local installation in several ways.

» Tar theimage and use ftp or secure ftp to send it to aremote
compulter.

e Useathird-party distribution system such as Microsoft Systems
Management Server (SMS).

e Burntheimageto a CD and distribute the CD.
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» Place the image on a shared network drive.

If you choose this option, make sure that the image's control file is
read-only before placing the image on the drive so that the file will
not be deleted after the first installation.

Once theimage is copied to the computer, it can be installed as described
in “Installing an Image on a Windows Computer” on page 2-18 or
“Installing an Image on a Unix Computer” on page 2-20.

Note
If you created an installable image on a Windows computer to be
installed on Unix computers, you must make sure that the method that
you use to transfer the image (for example, tarring the image) maintains
execute permission on the installable image files when you unpack the
files on the Unix computer. If the permissions are not maintained, you
may receive the following error message when you try to install the
image: "Error: Executable not found './thorinst.s25 .To
correct the file permissions, before you install the image, change to the
directory where the unpacked image files are located and enter the
following command: chmod 755 -R *.
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Installing an Image on a Windows Computer

Summary:

Step 1

Step 2

This procedure describes installing a product image locally in a Windows
environment on the computer to which it was deployed.

Once the installable image has been deployed, on the computer where
you want to install the image, change to the directory that contains the
imagefiles.

Open a command prompt and launch the installation utility by entering
the following command:

install.exe options

where options are any command line options that you want to specify as
listed in Table 2-2, on page 2-19.

Theinstallation utility executes and installs the products associated with
the image to the installation directory that you specified in the
installation utility when you created the image. No status messages are
displayed on the command line until the installation is complete. A log
fileis created in the directory where the image is stored that lists the
products installed and whether or not the installation was successful.

Note

If you close the command prompt before you seethel nst al |
conpl et ed status message, you will terminate the installation.
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Table 2-2 Installable Image Command Line Options for Windows

Option

Definition

-V

displays the installation utility version on the
command line then returns to the command line
prompt

-h

displays the available command line options

-path directory

lets you specify the path name to the installable
image if you are not in the same directory

-log location

lets you specify the location where you want to
store the log files. If not specified, the files are
stored in the directory where the image was
created.
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Installing an Image on a Unix Computer

Summary:

Step 1

Step 2

This procedure describes installing a product image locally in a Unix
environment on the computer to which it was deployed.

Once the installable image has been deployed, on the computer where
you want to install the image, change to the directory that contains the
imagefiles.

Launch the installation utility by entering the following command:
Jinstall.sh options

where options are any command line options that you want to specify as
listed in Table 2-3, on page 2-21.

Theinstallation utility executes and installs the products associated with
the image to the installation directory that you specified in the
installation utility when you created the image. No status messages are
displayed on the command line until the installation is complete. A log
fileis created in the directory where the image is stored that lists the
products installed and whether or not the installation was successful.

Note

If you close the command prompt before you seethe| nst al |
conpl et ed status message, you will terminate the installation.
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Table 2-3 Installable Image Command Line Options for Unix

Option Definition

-v displays the installation utility version on the
command line then returns to the command line
prompt

-h displays the available command line options

-log location filename lets you specify the directory location where you

want to store the log file and, optionally, the name
of the log file to be stored in that location. If you do
not specify a log file name, the default log files,
install.log and install.log_user, are created in the
location that you specify. If you do not specify a
location, the log files are created in the directory
where the image was created.

-install location installs the products from a control file stored in the
location that you specify. If not specified, the
installation utility looks for the control file in the
directory where the image was created.

-output location lets you specify the location where you want to
store the output messages log file
(install-output.log). If not specified, the file is
stored in the directory where the image was
created.

Editing Control Files for Installable Images

The ctltool is a utility that you can use to change the variables that are
stored in acontrol file. The control file stores the information that you
enter in the installation utility, such as installation directory and any
product configuration information. The installation engine uses the
information stored in the control fileto install the productsin the location
and with the configuration that you specify.

You can use the ctltool to edit any control file, but it is particularly useful
when you are creating an installable image, because you can change
product configuration values for the image without having to create a
new image.
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For example, if you created an installable image of products to be
installed on several Windows NT computers, but one of these computers
has a different password and product installation directory than the other
computers, in previous versions of the installation utility, you would have
to create a new image to change these values. With the ctltool, you can
change the values in the image’s existing control file to create a new
control file, then use the new contral file to install the same image on the
computer that requires the different values.
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Using the ctltool to Edit Control Files for Installable Images in Windows

Environments

Summary:

Step 1

Step 2

This procedure describes how to edit the variables stored in an installable
image's control file.

Change to the\Install\instbin directory in the directory where the
installable image is stored.

From a command line, enter the following command:
ctltool.exe drive:\path\inputfile.ctl drive:\path\outputfile.ctl

The variable drive:\path\inputfile.ctl represents the path to and name of
the control file that you want to edit (the control file that was created with
the installable image), and the variable drive: \path\outputfile.ctl
represents the path to and name of the new control file that you want to
create.

For example, you create an installable image and store theimagein a
directory on your D: drive called installableimage. When you create the
image, the installation utility creates a .ctl file named install.ctl and stores
that filein that directory along with the image. To edit this control file
and create anew one in the same directory, at the command prompt, you
would change to D:\installable image\l nstall\instbin, and enter

ctltool.exe “ D:\installableimagelinstall.ctl” “ D:\installable
image\newfile.ctl”.

Note
If the path that you enter for the input control file or the output control
file has aspace in it, you must enclose the path in quotes.

The ctltool displays each variable name and its current value. You can
enter anew value or keep the existing value. If you are changing a
password variable, the value is encrypted in the new contral file.
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Step 3 Rename the new control file to install.ctl so that when you install the
image, the installation utility usesthe new control file. The installation
utility looks for a control file named install.ctl to perform the installation.
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Using the ctltool to Edit Control Files for Installable Images in Unix
Environments

Summary:  This procedure describes how to edit the variables stored in an installable
image's control file.

Step1  Changeto the/Install/instbin directory in the directory where the
installable image is stored.

Step 2 Enter the following command:
ctltool.sh path/inputfile.ctl path/outputfile.ctl

The variable path/inputfile.ctl represents the path to and name of the
control file that you want to edit (the control file that was created with the
installable image), and the variabl e path/outpuitfile.ctl represents the path
to and name of the new control file that you want to create.

For example, you create an installable image and store theimagein a
directory called installable image. When you create the image, the
installation utility creates a.ctl file named install.ctl and storesthat filein
that directory along with the image. To edit this control file and create a
new one in the same directory, at the command prompt, you would
change to installable image/install/instbin, and enter

ctltool.sh “installableimage/install.ctl” “installable image/newfile.ctl” .

Note
If the path that you enter for the input control file or the output control

file has aspace in it, you must enclose the path in quotes.

The ctltool displays each variable name and its current value. You can
enter anew value or keep the existing value. If you are changing a
password variable, the value is encrypted in the new contral file.

Step 3  Rename the new control file to install.ctl so that when you install the

image, the installation utility uses the new control file. The installation
utility looks for a control file named install.ctl to perform the installation.
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Performing a Multiple CD Installation

Some products may require using multiple CDsto install all their
associated components. To perform a multiple CD installation, you must
provide atemporary storage location on your computer. You enter this
location in the Temporary space for copying external components window
in the installation utility. You need to provide only a directory location
(for example, C:\temp for Windows or /tmp for Unix). If the directory
that you enter does not exist, the installation utility will attempt to create
it.

Note
When you select the products that you want to install, the installation
utility displays the approximate disk space required to complete the
installation. When you perform amultiple CD installation, you must aso
make sure that the temporary directory that you specify has adequate disk
space to make a copy of al the components required by the product.

Creating the temporary directory may take afew moments. When the
directory has been created, you will be asked to load each of the required
CDsin sequence. Then, you will be asked to place the original CD back
in the CD-ROM drive. The installation utility will copy the required
pieces from each CD to the temporary space that you designate and
combine all thefiles for the installation. After the installation is
complete, the installation utility removes the copied files from the
temporary directory, and you may then del ete the temporary directory.

Note

On Unix systems, you cannot g ect removable mediawhile the mediais
being accessed; therefore, if your installation requires multiple product
images and you are using removable media, from a command line,

cd to/ then launch the installation utility by specifying the absolute path;
for example, /mnt/cdrom/setup.sh.
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Locating Log Files

When you complete a product installation, you will receive a status
message indicating the success or failure of the instalation. Also, you
can view ingtallation log files from the instalation utility. The following
sections describe where the log files are stored for both Windows and
Unix operating systems.

Tip
You can use the installation utility -trace command line option to create a
trace file that records detailed information about activitiesin the
installation utility interface during installation. Once the installation is
complete, the trace file information is added to the beginning of the
standard log file.

Location of Windows Log Files

Theinstallation utility stores the standard log filesin the following
directories:

For Windows NT:
C:\winnt\Profiles\username\Application Data\BM CINSTALL
For Windows 2000:

C:\Documents and Settings\username\Application
Data\BM CINSTALL

By default, the Application Data directory on Windows operating
systems is hidden. To view this directory so that you can locate the
installation log files, open Windows Explorer and for Windows NT,
choose View => Options => Show all files. For Windows 2000 and
Windows X P, choose Tools => Folder Options => View => Show hidden
filesand folders.
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Location of Unix Log Files

The installation utility stores the standard log files in the following
directory:

$HOME/BMCINSTALL

Installing an Agent or Console Patch to Your
Environment

A product package is a compressed file containing one or more product
files; it may contain al product filesfor afull release or only those
product files that have been added or changed for a patch release.

Warning

This procedure applies only to patches for the PATROL Agents and
consoles. Do not use this procedure to apply patches to PATROL KMs.
See the technical bulletin provided with your KM for specific patch
information.

System requirements for each product are listed in the README file for
the patch, or in the product rel ease notes or documentation. Be sure to
check that your system meets the regquirements before proceeding with
the installation.

Accessing the BMC Software Support Web Site

The BMC Software Support Web site islocated at
http://ww.bmc.com/support.html. Log on to the Web site and click the
Complete List of Products link to view an aphabetical list of BMC
Software products. If you are afirst time user, you can request a user
name and password either by clicking Register for a Login ID on the
support page or by contacting a BMC Software sal es representative.
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http://www.bmc.com/support.html

At thelist of products, click the name of the product you want to update.
The product’s Web page is displayed and shows any available patches or
new versions of the product. For more information about the BMC
Software Support Web page, contact your BMC Software sales
representative.

Note
On the BMC Software Support Web site, you can register for proactive
notification for your products. Click Tell Me About Proactive Natification
Service to begin the registration process. You must be a registered BMC
Software Customer Support Web site user with avalid login ID and
password to receive proactive notification. Once you register, you will
receive email notification when one of your products has been updated.
You can then access the products as described in the following
procedures to upgrade your environment.

Downloading the Patch

Patches are distributed on the FTP site. You can accessthe BMC
Software FTP site using one of two methods:

DOS command window
*  Web browser
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Accessing the FTP Site From a DOS Command Line

Step 1

Step 2
Step 3

Step 4

Step 5
Step 6

Step 7

Step 8

Complete the following task to access the FTP site from a command line.

From acommand line, enter ftp ftp.bmc.com to log in to the FTP site.
The | P address for ftp.bmc.com is 198.64.253.548.

Enter anonymous in the User Name field.

Enter your e-mail address in the Password field.

Change to the /pub/patrol/patches directory by typing cd
Ipub/patrol/patches. Be sure to specify products for your specific
platform.

Change to the directory that contains the product you want to upgrade.

Set the transfer mode to binary by typing binary.

Retrieve the patch you want by typing get patchname.exe at the command
prompt.

If you need the PATROL installation utility, you can get the latest version
from the /pub/patrol/patchess COMM ON_INSTAL L 7.3.11 directory.
Change to the directory for the platform that you want to install on.
Change the transfer mode to binary, then type get installation_utility.exe
at the command prompt.

Accessing the FTP Site Using a Web Browser

Step 1
Step 2
Step 3

Step 4

Complete the following task to access the FTP site using a Web browser.
Open a Web browser.

Enter ftp.bmc.com in the URL field.

Double-click the folders to get to the /pub/patrol/patches directory.

Double-click the folder that contains the product you want to update.
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Step 5  Seect the product version and platform by double-clicking on the
appropriate folders.

Step 6  When you open the folder containing the product executables, select the
executable you want to download by clicking onit. You will be prompted
to save the executable to your hard drive.

Step 7 If the product that you are downloading has a readme file associated with
it, read this document before installing the patch into your environment.
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Installing the Patch

Summary:  This procedure describes installing a patch to a PATROL Agent or
console. This procedure can be used on Windows or Unix platforms.

Installing the Patch

Step1  Download the patch from the ftp site and save it to a directory as
described in “ Downloading the Patch” on page 2-29.

Step 2  Changeto the directory.

Step 3 Double-click setup.exe (Windows) or type ./setup.sh (Unix) and run the
installation utility to install the patch.

Patch Issues with the PATROL KMDS

The PATROL Knowledge Module™ Deployment Server™ does not handle
patch releases (that is, arelease containing only the product files that
have been changed or added, not the full product). If you are
downloading a patch release, you cannot install it directly into the
PATROL KMDS. See the product release notes or README file for
specific instructions.
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Command Line Options for
Launching the Installation Utility

This chapter describes the command line options that you can useto
specify certain functions when you launch the installation utility. It
includes the following topics:

Command Line Options for Windows Platforms. ............... 3-2
Using the Command Line Optionsfor Windows. ............... 34
Command Line Optionsfor Unix Platforms . .................. 3-16
Using the Command Line Optionsfor Unix ................... 3-18
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Command Line Options for Windows Platforms

The following sections describe the command line options for launching
the installation utility on Windows platforms so that you can extend the
functionality of the installation utility.

Table 3-1 describes the command line options that you can use to launch
the installation utility from a command line in Windows environments.
For details on each option, see “ Using the Command Line Options for
Windows” on page 3-4.

Table 3-1 Command Line Options for Windows Installation (Part 1 of 2)
For
Option Definition Details
-h, -?, -help displays the list of command line options see page
3-4
-kmds allows you to install a KM directly into the see page
PATROL KMDS 3-5
-kmdsportnum use this option with the -kmds option; see page
portnum allows you to specify the port number to 3-6
use when you install a KM into the PATROL
KMDS
-locale locale installs language-specific resource files for | see page
the language that you specify 3-7
-port portnum allows you to specify a port number to use | see page
to connect to the installation Web server 3-8
-releaseversion runs older install scripts. Use this option if see page
version you are installing a new KM into a previous | 3-9
release of PATROL.
-repository_design | allows you to select a system role from the | see page
ator role command line so that the products that are | 3-10
displayed in the Select Products and
Components to Install window are filtered
for the roles that you specify.
-repository_oslist use this option when you create an see page
ostag installable image of products; allows you to | 3-11

specify a list of platforms on which you
want the image to install
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Table 3-1 Command Line Options for Windows Installation (Part 2 of 2)

For
Option Definition Details
-serveronly use this option if you do not have a browser | see page
on the computer on which you want to 3-12
install products; allows you to start the
installation Web server on one computer,
then connect to that Web server using a
browser on another computer.
-timeout seconds allows you to specify the number of see page
seconds that the installation utility will wait | 3-13
for connection to the installation Web
server
-trace records detailed information about activities | see page
in the installation utility GUI during 3-14
installation
-v displays the version number for the see page
installation utility 3-15
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Using the Command Line Options for Windows

The following sections describe how to use each command line option.

-h, -?, -help

This option displays the list of command line options.
Syntax

setup. exe -h

setup. exe -?

setup. exe -help
Options

None.
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-kmds

In a PATROL environment, this option letsyou install a KM directly into
the PATROL KMDS if aPATROL KMDS existsin your environment. If
you want to specify a port number to use to connect to the PATROL
KMDS, you must use the -kmdsportnum option along with this option.
For details on the PATROL KMDS, see the PATROL Knowledge Module
Deployment Server Manager User Guide.

Syntax

set up. exe -knds

Options

None.
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-kmdsportnum portnum

In a PATROL environment, this option lets you specify a port number to
use to connect to aPATROL KMDS if you are installing KMs directly
into the PATROL KMDS. If you do not specify a port number, the
installation utility uses a default port number of 3182. You must use this
option with the -kmds option to specify the port number. For details on
the PATROL KMDS, see the PATROL Knowledge Module Deployment
Server Manager User Guide.

Syntax

set up. exe -knds -kndsportnum 1590

Options
Any number from 1 to 65534.
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-locale locale

Syntax

Options

This option lets you select and install only those products that are
compatible with the locale (language) that you specify. You can specify
only one locale. Theinstallation utility will filter the list of products that
will be displayed in the Select Products and Componentsto Install
window to display only those products that are either specific to the
locale that you specify or that do not have alocale designation.

If you do not specify an option, then the locale from the system on which
you are running the installation utility is used. If the system locale is not
supported by the installation utility, then the English locale, en_US, is
used. This option does not change the language of the text displayed in
the installation utility. Theinstallation utility will runin English
regardless of the system locale or the -locale option that you enter except
as noted. In addition, you will be able to input only English characters.

Note
If you set the -locale option to be the same as the system locale, you will

install the appropriate products and language resource files, but the
installation utility will run in either English or the system local e language
and will accept input in either English or the system locale language.

setup. exe -locale en_US

Language Option
English en_US
Traditional Chinese zh_TW
Simplified Chinese zh_CN
Korean ko KR
Japanese ja_JP

BMC Software, Inc., Confidential and Proprietary Information

Command Line Options for Launching the Installation Utility 3-7



-port portnum

This option lets you specify a port number to use to connect to the
installation Web server. Use this option if the port number to the Web
server is locked and you want to specify another open port, or if you are
using the -serveronly command line option and you need to open a port
through afirewall. If not specified, the default value is 50001. If this port
number isin use, the installation utility increases the number by one and
tries again to connect to the Web server.

Syntax

setup. exe -port 3184

Options

Any number from 1 to 65534.

BMC Software, Inc., Confidential and Proprietary Information

3-8 PATROL Installation Reference Manual




-releaseversion version

In a PATROL environment, this option lets you install anew KM into an
existing PATROL environment.

Syntax
setup. exe -rel easeversion 3.4
Options
Option Description
3.2 for 3.2.x platforms and components
3.3 for 3.3.x platforms and components
34 for 3.4.x platforms and components
3571 for 3.5.x and 7.1.x platforms and components.
These options should always be specified together.
7.2 for 7.2 platforms and components. This is the
default for this version of the installation utility.
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-repository_designator role

This option lets you select a system role for the products that you are
installing. Products with a particular system role will be displayed in the
Sdlect Products and Components to Install window. The options that you
specify vary from product to product. Valid options can be found in the
sysrolesxml file in the BM CINSTAL L\Index directory. If you specify this
option, the System Roles window in the installation utility will not be

displayed.
Syntax

set up. exe -repository_designator PAT, PAA
Options

Depends on the products that you are installing. See the sysroles.xml file
for valid options.
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-repository_oslist ostag

Syntax

Options

This option lets you create an installable image on one Windows
operating system and install the image on another Windows or Unix
operating system.

Note

You cannot create one installable image that can be installed on both
Windows and Unix computers. You must create two separate images, one
for Windows platforms and one for Unix platforms.

setup.exe -repository oslist int_nt.40,int_nt.50

where the operating system tag that you specify is the valid operating
system tag required by the installation utility to create an image that can
be installed on a specific operating system. You must specify atag for
each operating system on which you want the image to install.

Table 3-2 lists the tags that you must enter for each Windows operating
system supported by the installation utility. Table 3-4, on page 3-26 lists
the tags that you must enter for each Unix operating system supported by
the installation utility.

Table 3-2  Operating System Tags for Creating an Installable Image for
Windows Platforms

Target Valid -repository_oslist
Operating System | tags required

Windows 4.0 int_nt.40

Windows 2000 int_nt.50

Windows XP int_nt.51

Windows .NET int_nt.52
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-serveronly

This option lets you start the installation Web server on one computer,
then connect to that Web server using a browser on another computer.
Usethis option if you do not have a browser on the computer where you
want to install products. When you launch the installation utility with this
command line option, the installation Web server is started, and a
message box is displayed that shows a URL. On the computer with the
browser, start the browser and enter this URL to connect to the Web
server.

Warning
The -serveronly command line option is not secure over a network and
using it in an unsecured network environment could result in security
violations. If thisis an issue for your environment, you may want to
consider either performing only local installations or creating an
installable product image that can be sent to a remote computer and
installed on it locally, rather than installing over an unsecured network.
For details on creating an installable image, see “Creating, Distributing,
and Installing Installable Images’ on page 2-13.

Syntax

set up. exe -serveronly

Options

None.
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-timeout seconds

This option lets you specify the number of seconds that the installation
utility will wait to connect to the installation Web server.

Syntax

setup. exe -tinmeout 120

Options
Any number from 120 to 500.

BMC Software, Inc., Confidential and Proprietary Information

Command Line Options for Launching the Installation Utility 3-13



-trace

This option lets you record detailed information about what is happening
in the installation utility GUI during a product installation. This
information is added to the beginning of the standard log file. You can
select to view the standard log file from the installation utility when the
installation is complete.

For information where to find installation log files, see “Locating Log
Files’ on page 2-27.

Syntax

setup. exe -trace

Options

None.
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This option displays a dialog box with the version number for the
installation utility but does not launch the installation utility.

Syntax
setup. exe -v

Options

None.
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Command Line Options for Unix Platforms

The following sections describe the command line options for launching
the installation utility on Unix platforms so that you can extend the
functionality of the installation utility.

Table 3-3 describes the command line options that you can use to launch
the installation utility from a command line in Unix environments. For
details on each option, see “Using the Command Line Options for Unix”

on page 3-18.
Table 3-3  Command Line Options for Unix Installation (Part 1 of 2)
For
Option Definition Details
-h displays the list of command line options see page
3-18
-kmds allows you to install a KM directly into the see page
PATROL KMDS 3-19
-kmdsportnum use this option with the -kmds option; see page
portnum allows you to specify the port number to 3-20
use when you install a KM into the PATROL
KMDS
-locale locale installs language-specific resource files for | see page
the language that you specify 3-21
-port portnum allows you to specify a port number to use | see page
to connect to the installation Web server 3-22
-releaseversion ver | runs older install scripts. Use this option if see page
you are installing a new KM into a previous | 3-23
release of PATROL.
-repository_design | allows you to select a system role from the | see page
ator role command line so that the products that are | 3-24
displayed in the Select Products and
Components to Install window are filtered
for the roles that you specify.
-repository_oslist use this option when you create an see page
ostag installable image of products; allows you to | 3-25
specify a list of platforms on which you
want the image to install
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Table 3-3  Command Line Options for Unix Installation (Part 2 of 2)

For
Option Definition Details
-serveronly use this option if you do not have a browser | see page
on the computer on which you want to 3-29
install products; allows you to start the
installation Web server on one computer,
then connect to that Web server using a
browser on another computer.
-timeout seconds allows you to specify the number of see page
seconds that the installation utility will wait | 3-30
for connection to the installation Web
server
-trace records detailed information about activities | see page
in the installation utility GUI during 3-31
installation
-v displays the version number for the see page
installation utility 3-32
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Using the Command Line Options for Unix

The following sections describe how to use each command line option.

-h

This option displays the list of command line options.
Syntax

./ setup.sh -h
Options

None.
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-kmds

In a PATROL environment, this option letsyou install a KM directly into
the PATROL KMDS if aPATROL KMDS existsin your environment. If
you want to specify a port number to use to connect to the PATROL
KMDS, you must use the -kmdsportnum option along with this option.
For details on the PATROL KMDS, see the PATROL Knowledge Module
Deployment Server Manager User Guide.

Syntax

./ setup. sh -knds

Options

None.

BMC Software, Inc., Confidential and Proprietary Information

Command Line Options for Launching the Installation Utility 3-19



-kmdsportnum portnum

In a PATROL environment, thislets allows you specify a port number to
use to connect to aPATROL KMDS if you are installing KMs directly
into the PATROL KMDS. If you do not specify a port number, the
installation utility uses a default port number of 3182. You must use this
option with the -kmds option to specify the port number. For details on
the PATROL KMDS, see the PATROL Knowledge Module Deployment
Server Manager User Guide.

Syntax

./ setup.sh -knds -kndsportnum 1590

Options
Any number from 1 to 65534.
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-locale locale

Syntax

Options

BMC Software, Inc., Confidential

This option lets you select and install only those products compatible
with the locale (language) that you specify. You can specify only one
locale. Theinstallation utility will filter the list of products that will be
displayed in the Select Products and Componentsto Install window to
display only those products that are either specific to the locale that you
specify or that do not have alocale designation.

If you do not specify an option, then the locale from the system on which
you are running the installation utility is used. If the system locale is not
supported by the installation utility, then the English locale, en_US, is
used. This option does not change the language of the text displayed in
the installation utility. Theinstallation utility will runin English
regardless of the system locale or the -locale option that you enter except
as noted. In addition, you will be able to input only English characters.

Note
If you set the -locale option to be the same as the system locale, you will

install the appropriate products and language resource files, but the
installation utility will run in either English or the system local e language
and will accept input in either English or the system locale language.

./ setup.sh -1ocale en_US

Language Option
English en_US
Traditional Chinese zh_TW
Simplified Chinese zh_CN
Korean ko KR
Japanese ja_JP
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-port portnum

This option lets you specify a port number to use to connect to the
installation Web server. Use this option if the port number to the Web
server islocked, and you want to specify another open port, or if you are
using the -serveronly command line option, and you need to open a port
through afirewall. If not specified, the default value is 50001. If this port
number isin use, the installation utility increases the number by one, and
tries again to connect to the Web server.

Syntax

./ setup.sh -port 3184

Options
Any number from 1 to 65534.
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-releaseversion version

In a PATROL environment, this option lets you install anew KM into an
existing PATROL environment.

Syntax
./ setup.sh -rel easeversion 3.4
Options
Option Description
3.2 for 3.2.x platforms and components
3.3 for 3.3.x platforms and components
34 for 3.4.x platforms and components
3571 for 3.5.x and 7.1.x platforms and components.
These options should always be specified together.
7.2 for 7.2 platforms and components. This is the
default for this version of the installation utility.
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-repository_designator role

This option lets you select a system role for the products that you are
installing. Products with a particular system role will be displayed in the
Sdlect Products and Components to Install window. The options that you
specify vary from product to product. Valid options can be found in the
sysrolesxml filein the BM CINSTALL/Index directory. If you specify this
option, the System Roles window in the installation utility will not be
displayed.

Syntax
./ setup.sh -repository_designator PAT, PAA
Options

Depends on the products that you are installing. See the sysroles.xml file
for valid options.
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-repository_oslist ostag

Syntax

Options

This option lets you create an installable image on one Unix operating
system and install the image on another Unix or Windows operating
system.

Note
You cannot create an installable image that can be installed on both
Windows and Unix computers. You must create two separate images, one
for Windows platforms and one for Unix platforms.

./ setup.sh -repository _oslist aix 41, hpux_ 1164

where the operating system tag that you specify is the valid operating
system tag required by the installation utility to create an image that can
be installed on a specific operating system. You must specify atag for
each operating system on which you want the image to install. Some
operating systems may require two tags to package and install all
components required by the productsin the image.

Table 3-4, on page 3-26 lists the tags that you must enter for each Unix
operating system supported by the installation utility. Table 3-2, on page
3-11 lists the tags that you must enter for each Windows operating
system supported by the installation utility.
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Table 3-4

Unix Platforms (Part 1 of 2)

Operating System Tags for Creating an Installable Image for

Target Supported Valid -repository_oslist
Operating System | Versions tags required
AIX (32-bit) 432 aix_41

433
AIX (64-bit) 432 aix_4364

433
AlX (32-bit) 5.1 aix_5132
AIX (64-bit with 32-bit | 5.1 aix_5164, aix_513264
kernel)
AIX (64-bit) 5.1 aix_5164
AIX (32-bit) 5.2 aix_5232
AIX (64-bit with 32-bit | 5.2 aix_5264, aix_523264
kernel)
AlX (64-bit) 5.2 aix_5264
HPUX 10.20 hpux_10.0, hpux_1020
HPUX (32-bit) 11.0 hpux_10.0, hpux_1132
HPUX (64-bit) 11.0 hpux_1164
HPUX (32-bit) 11i (B11.11) hpux_10.0, hpux_11.11_32
HPUX (64-bit) 11i (B11.11) hpux_1164, hpux_11.11 64
Linux Red Hat 6.1 linux_22, linux_rh_61
Linux Red Hat 6.2 linux_22, linux_rh_62
Linux Red Hat 7.0 linux_22, linux_rh_70
Linux Red Hat 7.1 linux_24, linux_rh_71
Linux Red Hat 7.2 linux_24, linux_rh_72

7.3

Advanced Server 2.1

Linux Red Hat (31-bit)

7.2 (zSeries)

linux390 24, s390 rh_72

Linux Suse 6.3 linux_22, linux_rh_61
Linux Suse 6.4 linux_22, linux_rh_62
7.0
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Table 3-4  Operating System Tags for Creating an Installable Image for
Unix Platforms (Part 2 of 2)

Target Supported Valid -repository_oslist

Operating System | Versions tags required

Linux Suse 7.1 linux_24, linux_suse_71
7.2
7.3
8.0

Linux Suse (31-bit)

Enterprise Server 7.0
(zSeries)

linux390, s390 _suse 70

Linux Suse (31-bit)

Enterprise Server 7.2
(zSeries)

linux390_24, s390_suse_72

Linux Suse (64-bit)

Enterprise Server 7.2
(zSeries)

linux390_24,
s390x_suse_ 72

Linux for s/390

linux390

Reliant Unix (64-bit) 5.4.4 reliant, reliant_544
Reliant Unix (64-bit) 5.4.5 reliant, reliant_545
SINIX 54.3 sinix
Solaris 25.1 solaris.25
Solaris 2.6 solaris.26
Solaris (32-bit) 7 solaris.2732
Solaris (64-bit) 7 solaris.2764
Solaris (32-hit) 8 solaris.2832
Solaris (64-bit) 8 solaris.2864
Solaris (32-bit) 9 solaris.2932
Solaris (64-bit) 9 solaris.2964
Trué4 4.0F dec osfl.4
4.0G
Tru64 5.0A dec_osfl_5.0
Tru64 5.1 dec_osfl 5.1
5.1A
DYNIX ptx 45.2 sequent_4.5
DYNIX ptx 46.1 sequent_4.6

BMC Software, Inc., Confidential and Proprietary Information

Command Line Options for Launching the Installation Utility

3-27



Example

To create an installable image on a computer running AlX 4.3.2 to be

installed on AIX 4.3.2 (32-bit) and Solaris 2.51, HPUX 10.20, and Red
Hat Linux 6.1, you would enter

Jsetup.sh -repository_odlist aix_41,solaris.25,
hpux_10.0,hpux_1020,linux_22,linux_rh_61
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-serveronly

This option lets you start the installation Web server on one computer,
then connect to that Web server using a browser on another computer.
Usethisoption if you do not have a browser on the computer where you
want to install products. When you launch the installation utility with this
command line option, the installation Web server is started, and a
message box is displayed that shows a URL. On the computer with the
browser, start the browser and enter this URL to connect to the Web
server.

Warning
The -serveronly command line option is not secure over a network and
using it in an unsecured network environment could result in security
violations. If thisis an issue for your environment, you may want to
consider either performing only local installations or creating an
installable product image that can be sent to a remote computer and
installed on it locally, rather than installing over an unsecured network.
For details on creating an installable image, see “Creating, Distributing,
and Installing Installable Images’ on page 2-13.

Syntax

./ setup.sh -serveronly

Options

None.
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-timeout seconds

This option lets you specify the number of seconds that the installation
utility will wait to connect to the installation Web server.

Syntax

./ setup.sh -tineout 120

Options
Any number from 120 to 500.
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-trace

This option lets you record detail ed information about what’s happening
in the installation utility GUI during a product installation. This
information is added to the beginning of the standard log file. You can
select to view the standard log file from the installation utility when the
installation is complete.

For information where to find installation log files, see “Locating Log
Files’ on page 2-27.

Syntax

./ setup.sh -trace

Options

None.
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This option displays a dialog box with the version number for the
installation utility but does not launch the installation utility.

Syntax

./ setup.sh -v

Options

None.
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Configuring Products

This chapter describes the configuration of products after installation. It
includes the following topics:

Configuring theInstalled Products. .. ........................ 4-2
Configuring PATROL Agents and Consolesfor Unix. ........ 4-3
Running the Configuration Script on aUnix Computer . .. .. .. 4-4

PATROL Environment Variables . . ........... ... ... ...t 4-5
Setting PATROL Environment Variables. .................. 4-6

Supplying License Information . ............................ 4-7

Setting Baselines to Begin Monitoring Your Environment ... ... .. 4-8
Creating aBaseline Functionality Plan . ................... 4-8
Determining Baseline Parametersand Thresholds ........... 4-9
IntegrationPlan . ......... ... . i 4-10
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Configuring the Installed Products

After installing PATROL, you may need to do a certain amount of
configuration to enable monitoring and viewing of data. Usually,
operating-system KMs are self-configuring and require no setup on your
part. However, many other KMs do need to be configured; see the getting
started guides for the products that you areinstalling.

The explanations in this section assume you will use a PATROL
Developer Console to perform this configuration. However, having a
developer consoleis not essential. As an aternative, you could use the
PATROL Configuration Tool, which performs a limited set of
configuration functions for agents and KMs.

To use a developer console to complete the configuration, you will need
to

start a PATROL Developer Console

e connect the console to agent machines (Add Hosts)

e load KMsinto memory (Load KMs)

« perform any required configuration to make the KMs operable

e preload the KMsto allow the PATROL Agent to run autonomously,
meaning that the agent will monitor and manage your system without

having a console connected to it

» disable the KMsto temporarily or permanently block the PATROL
Agent from loading them.

Note

This section presents summary information only. For detailed
explanations, see the user guide for your PATROL console platform.
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Configuring PATROL Agents and Consoles for Unix

Note
This procedure is applicable only for PATROL Consoles, PATROL
Agents, and PATROL Event Managers installed on computers running
under a Unix operating system.

If you provide the root password for each system where PATROL is
installed, the installation utility configures and starts the PATROL Agents
and configures the PATROL Consoles.

The configure.sh script automates the process of identifying the PATROL
Consoles and PATROL Agentsthat should be active on your hardware.
You must run configure.sh for every agent, console, and event manager
that you intend to activate but that the installation utility did not
configure. The installation utility places the configuration script on each
computer asit installs the PATROL products.
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Running the Configuration Script on a Unix Computer

Before You Begin

Summary:

Restriction

Thistask describes how to run the configuration script to configure the
PATROL Consoles and Agents on a Unix computer.

To complete this procedure, you must know the root password for each
computer that has PATROL products that you want to configure.

You cannot execute the configuration script from an NFS-mounted
directory if the root account has not been granted root access privileges
on the NFS server.

You must run the configuration script on each computer on which you
want to configure PATROL products.

To Run the Configuration Script

Step 1

Step 2

Step 3

Type the following command and press Return to log on as the root user:
% su

On some systems, use the following alternative command:

% su -

The operating system prompts you for a password.

Type the password for root and press Return.

Use the cd command to change the current directory to the directory

where the PATROL products were installed. (For example,
cd /users/patrol/PATROL.)
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Step 4 Typethefollowing command and press Return.
#./configure.sh

The configure script sets the user ID to root for the PATROL Console,
PATROL Agent, and PATROL Event Manager Console executables as
applicable.

PATROL Environment Variables

When you use the startup scripts for the PATROL Agent and Consoles,
the scripts set the required environment variables. Some of the utilities
provided with PATROL do not have the startup scripts. The PATROL
environment variables must be set properly to use the following PATROL

utilities:

e PatrolCli
e pconfig
. psl
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Setting PATROL Environment Variables

Summary:  Thistask describes how to run a PATROL script to set environment
variables for PATROL utilities.

To Set PATROL Environment Variables
Step1  Changedirectories (cd) to the $SPATROL_HOM E directory.
Step 2 Follow the appropriate procedure.

e For Korn or Bourne shells, type the following command and press
Enter.

..Ipatrolrc.sh
e For C shdlls, type the following command and press Enter.
source ./patrolrc

The script sets the required environment variables.
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Supplying License Information

PATROL products are installed with a 30-day demonstration license.
When you install PATROL as atrial, you do not enter any passwords or
license information. To use the product after 30 days, you must either
extend the demonstration license or install a permanent license. Your
sales representative or the Contract Administration department will
supply the information you need when you purchase a permanent license.

Thefirst time you start a PATROL Classic Console after your trial period
expires, the PATROL License dialog box is displayed. Alternatively, you
can display this dialog box at any time by choosing Options=> Licensein
the PATROL Console main window.

To activate your permanent license, enter the required information
exactly as it was given to you by BMC Software:

PATROL License Field What You Type. ..

Licensee company name

Expiration Date [dd-mmm-yyyy] leave blank for a permanent license
Number of console licenses number of PATROL Consoles stated

by BMC Software Contracts
Administration

Number of agent licenses number of PATROL Agents stated by
BMC Software Contracts
Administration

Password password provided by BMC Software
Contracts Administration

Note
Your product license password is validated based on the exact
information you supply in the License dialog box. If you do not enter this
information correctly, you will receive an error message.

You might be required to enter this information multiple timesif you are
given more than one password for the PATROL products you have
purchased.
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If the PATROL Consoleisinstalled on a Unix computer, and you have a
PATROL Agent installed on a Windows NT 4.0 or Windows 2000
computer, you may need to copy the license file from the computer with
the console to % PATROL_HOME%\lib on the computer with the agent.
Distribute the license.hostname file from a computer with a PATROL
Console to each computer with a PATROL Agent. You must remove the
hostname file extension after you distribute the license file or the agent
will be unable to find the file. You can use ftp or the xpconfig utility to
distribute the license on Unix platforms. See the PATROL Agent
Reference Manual for more information.

Setting Baselines to Begin Monitoring Your
Environment

Once you have installed the products, you can begin using them to
monitor applications and other itemsin your environment. The following
sections describe the recommended approach for creating a baseline and
for determining baseline parameters and thresholds.

Creating a Baseline Functionality Plan

BMC Software recommends building a baseline with all alarms
inactivated for all KMs except the PATROL Agent Application Class.
This approach allows you to give priority to setting thresholds for critical
parameters first.

However, if you have immediate pay-back objectives that need to be
addressed as soon as PATROL isinstalled, implement these objectives as
part of the baseline used in the initial rollout. These immediate pay-back
tasks should be highly scrutinized, with an objective of addressing the
top three to five tasks only.
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Determine which objectives fall into the immediate pay-back category by
asking, “If we do this, will it justify our PATROL purchase?’ Most
businesses have arelatively small list of goals that they want PATROL to
accomplish at the start; if these are met, they feel that their expenditure
on PATROL was warranted.

Once you develop the Baseline Functionality Plan, you might consider
these tips.

« Makethe KM parameter thresholds as simple as they can be to still
support your business requirements.

e Set thresholds to limit the number of warnings and alarms and to
accommodate critical business issues in the baseline distribution.

« Focuson the critical business issues associated with the warnings and
alarmsthat are turned on.

e Do not allow alarmsto occur until you understand the PATROL
product and your environment completely.

e Capture history (the PATROL parameter data points) on an ongoing
basis so that you can make the best decisions on threshold values and
future changes.

When you install a new version of PATROL, you must transfer the KM
customizations you made to the current version of PATROL to the new
version. This processis referred to as migration. Consult the PATROL
Migration Tools User Guide to learn recommendations for customizing
your KMs in amanner that will make future migration efforts easier.

Determining Baseline Parameters and Thresholds

The PATROL policy-planning methodology specifiesthat you determine
baseline parameters and thresholds by considering your enterprise
Service Level Objectives (SLOs). You then convert these parameters and
thresholds into a summary list of Critical Success Factors (CSFs).
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Next you select specific targets from CSFs and, for each specifically
targeted CSF, determine the associated events. Finally, evaluate the
parameters to determine which ones support each event.

The steps for establishing baseline parameters and thresholds are
summarized in Figure 4-1.

Figure 4-1 Steps to Establish Baseline Parameters and Thresholds

Convert SLOs Identify events @ Determine
into CSFs associated with which
targeted CSFs parameters
support each

Integration Plan

If your implementation of PATROL includes communication with
third-party products for event management or distribution, you must have
an integration plan. The following issues are associated with integrating
existing applications with PATROL :

e communication protocol
» filtering of event messages
e recovery action ownership
e enterprise management integration
— SNMP integration
* reliability of delivery
e some ability to code or “tokenize” packets
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Upgrading to a New Version of

PATROL

This chapter provides basic information you need to upgrade to a new
version of PATROL while preserving the customizations in your current
installation. It includes recommended workflows and strategies for
streamlining this process.

For more detailed information on migrating customizations, see the
PATROL Migration Tools User Guide.

Upgrading and Migrating: Basic Principles. .. ................. 5-2
How Customizations Can Be Preserved During Upgrade . ........ 5-2
Tools Required for Migration. ............. ..., 5-3
Using a Test Computer for FirstUpgrade ..................... 54
Backing Up Your Ingtallation. .............................. 5-4
Installation Checklist for aProduct Upgrade. .................. 5-6
Over-the-Top Ingtalation. .. ......... ... ... ... 5-7
Locating Your PATROL Directories. . ..........ccoiiinn... 5-8
Checking the Settingson Windows. . ..................... 5-9
Checkingthe SettingsonUnix ..................covu... 5-10
Strategies for Managing Customizations. . .................... 5-11
Customizationstothe PATROL Agent . ................... 5-11
Customizationsto KnowledgeModules ................... 5-12
CustomizationstoPSL Code. . ........... ... ..., 5-13
Customizationsto Event Catalogs. . .. .. .o vei it 5-14
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Upgrading and Migrating: Basic Principles

The fact that PATROL can be fully customized to suit your environment
and goalsisone of its main strengths. However, it also means that when
you upgrade to anew version of PATROL, you have to take careto
preserve all the customizations you have made to your current version.

Migration is the process of transferring customizations from an earlier
version of PATROL to anew version. BMC Software provides toolsto
automate the migration process as much as practical.

Performing amigration procedure is not recommended for usersthat are
unfamiliar with PATROL. Be sure that you review the PATROL
Migration Tools User Guide thoroughly before you migrate your
customizations.

How Customizations Can Be Preserved During
Upgrade

The customizations you make in PATROL fall into four broad categories:

Customizations to Are preserved by

console over-the-top installation of the PATROL 3
desktop layouts consoles
user preferences
list of loaded KMs migrating with the PATROL Console Migration

list of connected agents | Tool to the PATROL 7.x consoles; see the
PATROL Central Operator — Microsoft
Windows Edition Getting Started or the
PATROL Central Operator — Web Edition
Getting Started

agent over-the-top installation
agent configuration files
parameter history files
event history files
Standard Event Catalog
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Customizations to Are preserved by

Knowledge Modules
modifications to .km files migrating with Merge Tool
shipped by BMC software

new .km files created by over-the-top installation
user

PATROL Script Language
modifications to .psl files manually re-creating after installation
shipped by BMC Software

new .psl files created by over-the-top installation
user

For alist of al the files where customizations can be stored, see the
PATROL Migration Tools User Guide.

Tools Required for Migration

Thefollowing table lists the tools that you can use to perform amigration
procedure. For more information, see the PATROL Migration Tools User
Guide.

Table 5-1  Tools for Migration (Part 1 of 2)

Tool Function

Migration probe compares the KMs you have installed with base
versions shipped by BMC Software to find the
closest matches

Merge tool determines the differences between your modified
KM and the base KM; maps those differences to
the new version of the KM you are installing to
produce a “merged KM” that incorporates all your
customizations

KM archive contains key files for multiple versions of each KM
that have been shipped by BMC Software (the base
KMs); used by the probe to identify which base KM
most closely resembles your modified KM
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Table 5-1  Tools for Migration (Part 2 of 2)

Tool Function
pslsearch scans files for illegal use of PSL keywords
kmtool used to parse KMs and to generate a variety of

reports about KMs; useful for verifying that merged
KMs contain all your customizations

PEP (PATROL provides basic information about the current
Environment Probe) | installation, such as value for %PATROL_HOME%
and %PATROL_CACHE%; available only on
Windows

Using a Test Computer for First Upgrade

PATROL isasystem monitoring product and thereforeinstalls
components that interface with your system at the system levd. If you are
not thoroughly familiar with PATROL, installing it directly into a
production environment could result in undesirable conseguences.

Therefore, BMC Software strongly recommends that you install the new
version first in atest environment or lab situation.

Make sure that the test computer replicates all the essential components
of your production environment so you can validate the installation
reliably.

Backing Up Your Installation

As aprecaution, you should always back up the current PATROL
installation before you start to install a new version. In particular,
installing the new version of the product can overwrite the customized
files you aready have. Although you could take many approachesto
avoid this problem, the safest, quickest method isto do afull backup of
the directories where PATROL executables and data are stored.
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For Unix platforms, you should back up the following directories:

$BMC_ROOT (which includes $PATROL_HOME)
$PATROL _CACHE on classic console

/etc/patrol.d

letc/bgs

For Windows platforms, you should back up the following directories:

% PATROL_HOME%
% PATROL_CACHE% on classic console

The PATROL_HOME directories contain PATROL binaries, knowledge,
sounds, images, application defaults, help, utilities, and parameter
histories. The PATROL CACHE directories reside on the console
computer and are where the PATROL Console session changes are
stored. By default, PATROL_CACHE islocated in

% HOMEDRIVE% % HOM EPATH% \patrol for Windows environments
and in $HOME/patrol for Unix environments, where $SHOME isthe home
directory of the user who starts the console.

In a Microsoft Windows environment, you can use the PATROL
Environment Probe (PEP) to determine how these variables are set. To
start PEP, select Start => Programs => BM C PATROL => PATROL
Environment Probe.

In addition, if you have any PATROL data stored outside these
directories, be sure to back it up.
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Installation Checklist for a Product Upgrade

Use the checklist below to determine if you have all of the information
you need before you perform a product upgrade.

* All theitemslisted in “Installation Checklist for First Time
Installation” on page 2-6 also apply to an upgrade and have been
completed.

* You have gathered the following information about the current
installation:

— directories where PATROL products are installed
— account and port number used for PATROL Agents
— account used for previously installed products

* You have checked the documentation for each KM to see

— which KM versions can be migrated with merge tool

— if any configuration settings must be removed before installing
the new version

— if any services associated with the KM must be shut down before
installing the new products

— the name of the merge map file to use for thisKM

— if any application classes have been added, deleted, or renamed
in the new KM

— if any configuration is required after upgrading to the new
version
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Over-the-Top Installation

Note
Over-the-top installation is valid only for the PATROL Agent and the
PATROL Console.

Installing anew version of PATROL on top of an existing PATROL
installation will automatically preserve customizations to the agent and
console, including

» console desktop layouts and preferences

e agent configurations

e agent parameter history files

e agent event history files

e Standard Event Catalog

e the PATROL user rolesfile (ptriroles.txt or patrol.conf)

In addition, an over-the-top installation preserves

* the PATROL licensefile

KM filesthat were created in-house, not shipped by BMC Software

» PSL filesthat were created in-house, not shipped by BMC Software

» event catalog files that were created in-house, not shipped by BMC
Software

To take advantage of an over-the-top installation, you must specify the
same settings and default values that were used for the current
installation. Before you begin, gather the following information:

e installation directory for PATROL Agent and Console
e default account for PATROL Agent and Console
e port number for PATROL Agent

If you do not do an over-the-top installation to install a new version of
the PATROL Agent, you will have to migrate your agent and console
customizations manually to the new versions of the PATROL Agent and
Console that you installed in a different directory. For more information
on migrating agents and consoles manually, see the PATROL Migration
Tools User Guide.
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Table 5-2 shows the platforms and PATROL versions that are supported
for installing new PATROL products over the top of existing products.

Note
Over-the-top installation for Windows 2000 platformsis not supported

for versions of PATROL earlier than 3.4.00.

Table 5-2  Supported Platforms for Over-The-Top Installation

PATROL

3.3.00 and | PATROL
Platform later 3.4.00
Windows 2000 Intel X
Windows NT 4.0 Intel, SP4 and | x X
SP5
Windows NT 4.0 Intel, SP62 X X
Windows NT 4.0 Intel, TSE X X
SP3, SP4, and SP52

4 This platform is supported for PATROL 3.3.01 only.

For more information on migrating your KM customizations, see the
PATROL Migration Tools User Guide.

Locating Your PATROL Directories

PATROL executables and data are typically stored in two directories:

* $PATROL_HOME
* $PATROL_CACHE

Note

$PATROL_CACHE exists only on console machines and may be different
for each console user.
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$PATROL_HOME isset during ingtallation. $PATROL_CACHE isnot set
automatically; it must be set explicitly by the user. If SPATROL_CACHE
is not defined, the default location $HOM E\patrol (Windows) or
$HOME/patral (Unix) isused for storing the console user’'s
customizationsto PATROL .

Checking the Settings on Windows

To determine how % PATROL_HOME% and % PATROL_CACHE% are
currently set on a Windows machine, use either of the following
methods:

e Check the Environment tab on the Systems Properties dialog box
(Start => Settings => Control Panel => System => Environment).

* RunthePEP (Start => Programs => BM C PATROL => PATROL
Environment Probe).

The PEP provides a great deal of information about your PATROL

installation. You can save this information to afile for later reference or
open a saved file to compare former settings with the current val ues.
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Figure 5-1 PATROL Environment Probe

. ¢ PATROL Environment Probe M= 3
Open File Fie Vibw
Probe (refreshes data)p é| H| Computer: [ BAKERSZ_NT ‘
Savetofile —— | Mameter [ 5ta... [ Value [«]
2 Total physical memary ak. 133,599,232 bytes
D Global PATROL directory Ok D:WPATROLS-4
2) Global bin directory QK [:APATROL3-4bin
2) Global config directory QK [:APATROL3-4\config
D Global lib directory Ok D:WPATROLS-44ib
2 Global help directory QK [:APATROL3-4ibAhelp
2 Global KM directory QK [DoAPATROL3-4MibAknowledge
2 Global PSL directory QK [eAPATROL3-44ibApsl
2 Global log directory QK [LoAPATROLI-4og
2 Global history directory QK [e:APATROL3-4\oghhistory
2 User home directory QK Ly
Click on an item to see rectory | 0K | U:\ypatrl
a description ofitin 3Local congole chart divectory QK U:Mhspatrolhchart
Local conzole config directory - U:\patrolyzonfig : Directory not found
the lower pane. 2 Local conzole desktop directory QK U:Mhpatrolhdeskiop
2 Local console knowledge directony QK U:Mhpatroliknowledge
2 Local conzole PSL directory QK L:Mhpatralyps!
2 Local conzole tmp directory QK U:Mhpatrolytmp
D PATROL_ADMIN Ok patral
JPATROL_CACHE - Mot defined i
D PATROL_HOME Ok D:WPATROLS-4
2 Patroldgent. exe QK [:APATROL3-44bin\Patrolbgent. exe
2 PATROL Agent Service QK Installed. Service iz running LI
Description of selected PATROL Console saves local changes made in the current session in =]
. . subdirectaries under the local PATROL directory. By default, local
item is POSted here. PATROL directory is the subdirectory named “'patrol’ under the user
home directory. However, the default can be overidden by defining 1
the environment variable PATROL_CACHE to specify a different directory.
=]
Select an item to display more information in the lower pane. s

In the probe, Global PATROL directory isthe same as PATROL_HOME,
and Local console cache directory isthe same as PATROL_CACHE.

In the example above, PATROL _CACHE has avalue of Not defined

because the user did not explicitly set this variable, so the default location
is used for storing customizations.

Checking the Settings on Unix

To determine how $PATROL_HOME and $PATROL _CACHE are
currently set on a Unix machine, enter either of the following commands
a the system prompt:

>env | grep $VARIABLE_NAME
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or

>echo $VARIABLE_NAME

Strategies for Managing Customizations

Adopting some simple management policies will help you use and
maintain customizations to PATROL in the most efficient manner. These
best practices were gleaned from the experience of BMC Software
Support and Professional Services.

Customizations to the PATROL Agent

If you want to apply the same configuration settings to a number of
PATROL Agents, create asimple ASCII change file (.cfg) and distribute
it to al the agent machines by using the command-line utility pconfig.
On each machine, the change file is used in combination with the default
configuration file shipped by BMC Software to configure the agent.

This approach offers the following advantages:

e The changefile serves as arecord of your customizations.
e The changefile can be applied to new agents when they are installed.
e Thechangefileis preserved during an over-the-top installation.

See the PATROL Agent Reference Manual for more information on using
pconfig.

Another approach is to edit the config.default file and distribute the edited
file to each agent machine. An over-the-top installation will preserve
your customizations to the config.default when you upgrade to alater
version of PATROL.
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Customizations to Knowledge Modules

The key to managing KM customizations is to keep the amount of
variation to a minimum and to provide a mechanism for keeping track of
what you have in your environment.

Limit the Amount of Variations

A typical enterprise should have only a small number of unique versions
of any given KM. Limiting the number of variations like this makes it
easier for you to control what isin your environment and reduces the
amount of migration you have to perform when you upgrade. For
example, you might have customized PATROL for Microsoft Exchange
Server in two different ways: version A is applied to aset of 200 servers
and version B is applied to a set of 500 servers. When you upgrade
PATROL, you will only need to perform the migration twice.

Consider Using Operator Overrides

BMC Software recommends customizing the KM for global changes and
using operator overrides for local changes. For example, if you want the
same alarm ranges used for CPU usage on all hosts except five critical
servers, specify the common settings when you customize the NT_CPU
KM and then apply local overrides to the five exceptions.

This approach offers severa advantages to the alternative, which isto
customize the KM globally once and then customize it locally for each of
the specia instances.

«  Operator overrides are stored in the agent configuration files and thus
are automatically preserved when you later do an over-the-top
installation of anew version of PATROL, whereas the KM
customizations have to be migrated.

«  Operator overrides can be applied to a single application instance or
to all instances. Localizationsto a.km file must be made on an
instance-by-instance basis; as aresult, they can be time-consuming to
make and can increase the size of the .km file significantly.
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To make overrides, you must be running an operator console with the
appropriate user role defined (that is, the allowtuning variable has been
turned on in the ptriroles.txt file or the allowoverrideparameter has been
turned on in the patrol.conf file, depending on your version of PATROL).
You can then make changes to the following properties:

» application discovery cycle
e palling interval

e history retention span

e border range

e adarm thresholds

For more information, see the PATROL Console for Unix User Guide or
the PATROL Console for Microsoft Windows User Guide — Customizing
PATROL \olume 3.

Customizations to PSL Code

Any modifications you make to .pd files that were shipped by BMC
Software are lost when you install the new version of the product. On the
other hand, new .pdl filesthat you create in-house are preserved by an
over-the-top installation. This section deals exclusively with changes that
you may have made to PSL code shipped by BMC Software.

In addition, changes to PSL code that are embedded within the .km file

are not brought forward by the merge tool. But references to externa .pd

files are preserved and incorporated in the new version of the KM.

For these reasons, it is best to adopt the following practices:

« Avoid making changes to PSL code ddlivered by BMC Software if at
al possible. Such changes are not retained during the migration

process and must be manually re-created.

« If you must change BMC Software code, keep a copy of the origina
intact.
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« If you add PSL codeto aKM, storeit in a separate .pd file and
reference that file within the .km file. Do not embed PSL code within
the .km file. See Appendix C in the PATROL Migration Tools User
Guide.

» Keep arecord of the changes you have made and the reasons for
those changes. Comments within the code can be very helpful later.

Customizations to Event Catalogs

If you need to add or modify event classes, you can customize the
Standard Event Catalog (StdEvents.ctg) or the application event catalogs
(*.ctg) for KMs that are shipped by BMC Software.

e Customizationsto the Standard Event Catalog are preserved by an
over-the-top installation of the PATROL Agent. However, if you later
install PATROL Alarm Manager, that product installs its own version
of StdEvents.ctg, and any customizations you have made to the
Standard Event Catalog are lost.

e Customizationsto an event catalog for a specific application are lost
when you later install anew version of that KM. You must re-create
the customi zations.

Alternatively, you can create a custom event catalog that will be
preserved when you later upgrade to anew version of PATROL. To do so,
you must

» first create anew application class

« define an event catalog for that “dummy” application class

e apply your custom event catalog to KMs shipped by BMC Software
(that is, define what conditions trigger a certain type of event in your
new catalog)
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When you customize a KM, be sure to store the PSL code you writein a
separate .pd file; do not save it within the .km file. Because .pd files you
create are preserved by an over-the-top installation, your custom event
catalog and the PSL code defining the conditions that trigger various
types of events will remain intact. The references to those .psl fileswithin
the .km file are maintained when you merge your modified KM with the
new version. For more information on creating application classes and
events, see the user guide for your PATROL Console.
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Uninstalling Products

This chapter describes how to uninstall BMC Software products. It
includes the following topics:

Uninstalling BMC Software Products . .. ..................... 6-2
Uninstalling Products in a Windows Environment ........... 6-3
Uninstalling Productsin aUnix Environment. . ............. 6-6
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Uninstalling BMC Software Products

You can use the installation utility in uninstall mode to select and
uninstall only those products that were installed with this version of the
installation utility. Products installed with a previous version of the
installation program must use that version’s uninstall utility.

Warning

Performing the tasks described in this section may remove files needed
by aprevious version of the installation program to uninstall products
installed with that version. Likewise, if you use a previous version of the
installation program to uninstall products, you may remove files needed
by thisversion of the installation utility to perform the uninstall tasks.

Note
Before you can uninstall PATROL products, you may need to stop any
PATROL processes that are running on the computers where you want to
uninstall PATROL. For information on stopping PATROL processes, see
the PATROL for Unix Getting Started, the PATROL Agent Reference
Manual, and the PATROL Knowledge Module Deployment Server
Manager User Guide.
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Uninstalling Products in a Windows Environment

Summary:  You have several options for uninstalling BMC Software products
depending on what you want to uninstall. The following procedures
describe how to uninstall products in a Windows environment.

To Uninstall Individual Products

Step1  From the Uninstall directory in your BMC Software product installation
directory, double-click uninstall.exe to launch the installation utility in
uninstall mode.

Note
You can optionally launch the installation utility in uninstall mode by
choosing Start => Settings => Control Panel => Add/Remove Programs
and double-clicking on BMC Softwar e Tools in the Add/Remove Programs
Properties dialog box.

The Welcome window is displayed. Click Next.

Step 2  Select theinstallation directory from which you want to remove a
product. Click Next.

Step 3 Sdect the product or products that you want to uninstall. Click Next.
Step 4  Review your selections and click Uninstall.

Once the uninstall is complete, awindow is displayed that tells you the
status of the uninstall.

To Uninstall All Products but Leave Log Files and Configuration Files
Step 1  Uninstall al products as described in “To Uninstall Individual Products.”

Step 2 Locate the uninstall.ctl file in the <BM C Products I nstallation
directory>\Uninstall\I nstall\instdata directory.
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Step 3

Step 4

Step 5

Step 6

Open the uninstall.ctl filein atext editor such as Notepad and edit the
/BMC/Base variable to specify the name of the directory from which you
removed the productsin step 1.

Open a command prompt.

Change to the <BM C Products I nstallation directory>\Uninstall\ | nstall\
instbin directory.

Enter the following command:

thorinst.exe -uninstall path to contral file -log path to log file -output path to
output log file

where the -log and -output options let you specify alocation for a
standard log file and an output log file. The standard log file contains all
installation status information, and the output log file contains messages
on the progress of the installation that are normally sent to standard
output. The path to log file and path to output log file variables can be
any valid path and file name (with a .txt extension) that you specify. If
any of the paths (to control file, log file, or output log fil€) include
spaces, you must enclose them with quotes.

For example, if C:\Program Files\BM C Software is your product
installation directory, you would change to C:\Program Files\BM C
Software\Uninstall\ I nstall\instbin directory and enter the following:

thorinst.exe -uninstall “ C:\Program Files\BM C
Software\Uninstall\I nstall\instdata\uninstall.ctl” -log
Z:\Networ kL ogs\MyL ogs.txt -output Z:\Networ kL ogs\M yL ogs.out

Thistask removes all installation files and directories except those used
by the utility at the time the uninstall is performed. Log files,
configuration files, and user modified files are also retained.
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To Uninstall All Products and Associated Log Files and Configuration Files

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Uninstall al products as described in “To Uninstall Individual Products.”

Locate the uninstall-all.ctl file in the <BM C Products I nstallation
directory>\Uninstall\I nstall\instdata directory.

Open the uninstall-all.ctl file in a text editor such as Notepad and edit the
/BMC/Base variable to specify the name of the directory from which you
removed the productsin step 1.

Open a command prompt.

Change to the <BM C Products I nstallation directory>\Uninstall\ | nstall\
instbin directory.

Enter the following command:

thorinst.exe -uninstall path to contral file -log path to log file -output path to
output log file

where the -log and -output options let you specify alocation for a
standard log file and an output log file. The standard log file contains all
installation status information, and the output log file contains messages
on the progress of the installation that are normally sent to standard
output. The path to log file and path to output log file variables can be
any valid path and file name (with a .txt extension) that you specify. If
the path includes spaces, you must enclose it with gquotes.

For example, if C:\Program Files\BM C Software is your product
installation directory, you would change to C:\Program Files\BM C
Software\Uninstall\ I nstall\instbin directory and enter the following:

thorinst.exe -uninstall “ C:\Program Files\BM C
Software\Uninstall\l nstall\instdata\uninstall-all.ctl” -log
Z:\Networ kL ogs\MyL ogs.txt -output Z:\Networ kL ogs\M yL ogs.out

Thistask removes all installation files and directories. The files used to
perform the uninstall will be marked for deletion and will be removed
when the computer on which the products were uninstalled is rebooted.
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Uninstalling Products in a Unix Environment

Summary:  Thefollowing procedure describes how to uninstall BMC Software
productsin a Unix environment.

To Uninstall Individual Products
Step1  Changeto the Uninstall directory in your BMC Software product
installation directory and enter the following command to launch the
installation utility in uninstall mode:
Juninstall.sh

The Welcome window is displayed. Click Next.

Step 2  Select theinstallation directory from which you want to remove a
product. Click Next.

Step 3 Sdect the product or products that you want to uninstall. Click Next.
Step 4  Review your selections and click Uninstall.

Once the uninstall is complete, awindow is displayed that tells you the
status of the uninstall.
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PATROL Installation Directories

This appendix describes the basic structure of the PATROL installation
directories for Windows and Unix.

Product Installation Directory

Overview of the Installation Directory Structure for Windows. ... A-3
Overview of the Installation Directory Structure for Unix. ....... A-4
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Product Installation Directory

When you install products, you will need to provide the name of a
directory into which the products that you select will be installed. The
installation utility provides a default directory that you can use, or you
can enter anew directory.

Warning
Product installation directories are stored in installation utility history
files as full path names; therefore, do not rename the product installation
directory after you install products, because the installation utility will be
unable to find the renamed directory if you uninstall products.
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Overview of the Installation Directory Structure

for Windows

By default, the ingtallation utility uses c:\Program Files\BM C Software as
the product installation directory. When you install products, the
installation utility creates a subdirectory in the product installation
directory for each product that you install and the following additional
subdirectories that store information required by the installation utility:

Install\insthist—stores files that contain installation utility history
information, such as which products you installed during a particular
installation session

itools—stores utilities that may be used by the products that you
install

Uninstall\I nstal\instbase—stores the Perl binaries and the Perl Web
server code; Perl is used by installation utility to install products

Uninstall\I nstal\instbin—stores the installation engine binaries and
installation tools such as ctltool

Uninstall\Install\instcommon—stores the xml files that are used to
format and display the standard installation utility windows

Uninstall\l nstal\instdata—stores default text files that control the
order of thelist of productsthat you can select to install and the order
in which the products are installed, and that list the operating systems
that are recognized by the installation utility

The PATROL product directory contains subdirectories for binaries,
knowledge, images, application defaults, help files, and utilities.
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Overview of the Installation Directory Structure

for Unix

By default, the installation utility uses /opt/bmc as the product installation
directory. When you install products, the installation utility creates a
subdirectory in the product installation directory for each product that
you install and the following additional subdirectories that store
information required by the installation utility:

Install/insthist—stores files that contain installation utility history
information, such as which products you installed during a particular
installation session

itools—stores utilities that may be used by the products that you
install

Uninstall/I nstall/instbase—stores the Perl binaries and the Perl Web
server code; Perl is used by installation utility to install products

Uninstall/Ingtall/instbin—stores the installation engine binaries and
installation tools such as ctltool

Uninstall/Install/instcommon—stores the xml files that are used to
format and display the standard installation utility windows

Uninstall/Install/instdata—stores default text files that control the
order of thelist of productsthat you can select to install and the order
in which the products are installed, and that list the operating systems
that are recognized by the installation utility

Note

Be sure you have write permissions for /opt/BM C before you begin to
install products or the installation will fail.

The PATROL product directory contains subdirectories for binaries,
knowledge, images, application defaults, help files, and utilities.
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Using PATROL with Firewalls

This appendix describes how to use PATROL in environments that have a

firewall between the PATROL Consoles and PATROL Agents or between
the PATROL KMDS and other PATROL components. It isintended for
system administrators who can tailor their site environment to make
effective use of PATROL products. Depending on your type of firewall
and the location of your PATROL Consoles, Agents, and PATROL
KMDS reative to your firewall, you might need to modify your firewall
protection to use PATROL.

This chapter presents the following topics:

TCP and UDP CommunicationsBasics. . ..................... B-2
Port Requirements for InstallingonUnix .................. B-3
Port Requirements for Installingon Windows. . ............. B-3

PATROL Agent and Console Communication Basics............ B-3
UDP-Based Transport . ......oviiii i ieie i B-3
TCP-Based Transport. .. ....ooi e e e B-5
CommandLineExamples............. ... B-6
Using the/etc/servicesFile . ......... ... oo, B-7
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TCP and UDP Communications Basics

PATROL provides a choice of two transport protocols for
communications between PATROL components. UDP and TCP.

UDP is a connectionless protocol that sends independent datagrams
from one host to another, much like lettersin the post office. That is,
the host simply puts the message onto the network with the
destination address, and there is no attempt to make sure that the
message arrives at the destination, or that the messages arrive in the
same order in which they were sent.

TCP is aconnection-based service with two independent byte
streams going in opposite directions, like a telephone system with
two separate lines for communication in opposite directions. The
sender receives confirmation that the message arrives at the
destination, and the receiver handles them in the order in which they
were sent.

A TCP or UDP connection isidentified by the following four items
present in each message:

source |P address—address of the system that sent the packet
destination | P address—address of the system to receive the packet

source port—connection port at the source system; identifies the
process that sent the packet

destination port—connection port at the destination system; identifies
the process that should receive the packet

Port numbers enable multiple processesto use TCP or UDP serviceson
the same host.

Well-known ports are port numbers that industry has agreed to reserve for
specific services such astelnet, ftp, and SMTP. These well-known ports
are numbered from 1 through 1024. Port numbers greater than 1024 are
not considered to be well-known ports.
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Port Requirements for Installing on Unix

Installing PATROL or deploying KMs from the PATROL KMDS requires
that the following ports be open:

* RNC—8160

. FTP—21
« TELNET—23

Port Requirements for Installing on Windows

Installing PATROL or deploying KMs from the PATROL KM DS requires
that the following port be open:

* RNC—8160

Also, both computers must be members of the same domain. Thereisno
port mapping. The installation utility uses TCP.

PATROL Agent and Console Communication
Basics

This section examines the use of UDP and TCP communications
protocols with PATROL, and gives examples of each.

The PATROL Agent configuration variable,
/AgentSetup/PortConnectType, defines whether the agent listens on the

UDP protocol, the TCP protocol, or both. The default is for the agent to
listen on both protocols.

UDP-Based Transport

The following sections describe different uses for UDP-based transport.
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PATROL Agent Binding

The PATROL Agent normally binds to a fixed UDP and TCP port using a
default port number of 3181.

However, you can control the port to which the PATROL Agent binds
through use of command line options when you start the PATROL Agent.
For example, the following command starts the PATROL Agent on port
3100:

PatrolAgent -p 3100

See PATROL for Unix Getting Started for more information about
starting the PATROL Agent.

PATROL Console Binding

Normally, for UDP communication, the PATROL Console bindsto the
next available UDP port for return traffic, as determined by the operating
system.

However, the following command line options can be used to start the
PATROL Console on different ports:

Table B-1 PATROL Console Startup Arguments

Argument Function

-lcp <port_number> bind this port number to sockets created by xpconfig
to connect to agents

-lkp <port> bind this port number to sockets created to connect
to the PATROL KMDS

-lp <port> specific local port number to use behind a firewall

-p <port> default port for agent connections

If you have defined a PATROL Console UDP service, then the console
automatically binds to the UDP port number specified for this service.
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The firewall filtering router must be configured to allow the PATROL
Agents and PATROL Consolesto communicate. The exact configuration
is dependent on the location of your PATROL Consoles and PATROL
Agentsinrelation to the firewall. See “Command Line Examples’ on
page B-6 for more information.

A firewall using afiltering router is only marginally weakened by the
addition of the PATROL filters. The source and destination port numbers
are fixed. You can even further restrict the PATROL traffic allowed
through the firewall by including the IP address of your PATROL
Console machine in the filter. If you have several consoles, you can
include the network number of the network where your PATROL
Consoles are running in the filters.

TCP-Based Transport

Aswith the UDP-based transport, the PATROL Agent binds to afixed
TCP port number. However, as defined by standard TCP protocal, this
port number is used only in the TCP connection protocol. The operating
system assigns anew pair of pseudo random (ephemeral) port numbers to
the connection after the connection has been established. All traffic over
the connection is then addressed to these ports. This enables the TCP
application to continue listening for traffic on the first port, while data (in
this case, normal PATROL traffic) is being transferred over the ephemeral
ports.

Since the TCP protocol does not use fixed ports for data traffic after a
connection has been made, it is virtually impossible to create filtersto
alow only the PATROL traffic through the firewall, as discussed
previously for UDP.

To use TCP with afirewall, the firewall must be “ TCP-aware,” and it

must be configured properly. Refer to your firewall documentation for
detailed information about using the firewall with the TCP protocal.
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Command Line Examples

If you intend to run the PATROL Agent configuration from a PATROL
Deveoper Console (that is, use the MB3 Development => Agent
Configuration choice), you also must use the -Icp option when you start
the PATROL Console so that you force the PATROL Agent configuration
process to bind to a UDP port of your choice (for example, 1989).

If you have defined a xpconfig UDP service, the PATROL Agent
configuration process automatically binds to the UDP port; that is, you
don’t need to use the -Icp option in this case. For example, to start a
PATROL Developer Console that will connect to one or more PATROL
Agents through afirewall, type the following startup command:

Patrol -dev -Ip 1988 -Icp 1989

UDP port 1988 will be used by the PATROL Console process, and UDP
port 1989 will be used by the PATROL Agent configuration process.

The router must have one additional filter defined on each of itstwo
interfaces to allow the PATROL Consoles and PATROL Agentsto
communicate through the firewall. Your router filter tables might look
like those shown in the paragraphs that follow.

On the interface to the outside world (the PATROL Consol€'s network),
the following filter is needed:

Figure B-1 Router Port Filter—PATROL Console

# Al ow Sour ce Destination
# | Deny | P/ port/proto | P/ port/proto
Deny R * ¥R * # Default: deny all
Al | ow x| firewal I /*/* # To firewall
Al'l ow */1988/ UDP */ 3181/ UDP # Consol e-> Agent
Al'l ow */ 1989/ UDP */ 3181/ UDP # Agent Config-> Agent
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On theinterface to the PATROL Agent’s network, the following filter is
needed:

Figure B-2 Router Port Filter—PATROL Agent

# Al ow Sour ce Destination
# | Deny | P/ port/proto | P/ port/proto
Deny *[*R[* [ * # Default: deny al
Al | ow firewal | /*/* x| # Fromfirewal |
Al'l ow */ 3181/ UDP */ 1988/ UDP # Agent -> Consol e
Al'l ow */ 3181/ UDP */ 1989/ UDP # Agent-> Agent Config

Using the /etc/services File

The /etc/servicesfileis aUnix system file that defines well-known ports
and the services associated with those ports. The port number from one
to 1024.

Since services may also be defined in either Network Information
Services (NIS) or NIS+ tables, you need to know the specific location
from which your system obtains network services.

If you do not use the -p argument when you start the PATROL Agent or
PATROL Console, the PATROL Agent or PATROL Console will perform
alookup in the /etc/services file to see what port number should be used.

Thus, if you place the following two entries in the /etc/services file

pat r ol agent 2627/ udp
pat r ol agent 2627/ tcp

the system will start the PATROL Agent using port number 2627.
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If you start a PATROL Agent, a PATROL Console, or the PATROL
configuration utility without specifying a port number option, the
application checks the /etc/services file to see if any port number is
assigned to the application. If a port definition is found, the application
will use that port number; otherwise, it will use the default port number.
The default port number for the PATROL Agent is 3181 currently, and is
arandom number for the PATROL Console and for the configuration
utility. The default port number for the PATROL Agent may changein
the future. See the appropriate PATROL users guide for your platform for
the correct default port number designation.

The startup command for the PATROL Console uses two additional
arguments primarily for adapting PATROL to work with firewalls. These
arguments are shown in Table B-1, “PATROL Console Startup
Arguments,” on page B-4. If you do not use the -Ip or -Icp arguments
when starting the PATROL Console, the PATROL Console will read the
letc/services file for the keywords patrolconsole and patrolconfig,
respectively. If these services are not listed in the /etc/servicesfile, the
operating system will assign the next available port to the PATROL
Agent and PATROL Console when they start.

Note

The -lp and -lcp command line options are only applicableif UDP is used
as the connection protocol. These switches have no effect if the TCP
connection protocol is used.
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A sample /etc/services file is shown in Figure B-3. PATROL requiresthe
service names for the PATROL Agent and PATROL Consoleto be
exactly as shown in Figure B-3.

Figure B-3 Sample /etc/services File

t cpnux 1/tcp

pat r ol agent 27/ udp

pat r ol agent 2627/ tcp
patrol consol e 2628/ udp
patrol console 2628/tcp
patrol config 2629/ udp
patrol config 2629/ tcp

Patrol agent port for UDP
Patrol agent port for TCP
Patrol consol e port
Patrol consol e port
Patrol configuration port
Patrol configuration port

HHHHHH

Using /etc/services to specify port number for an application does not
reserve or start an application on the specified port. It issimply states that
aservice will use a particular port.

When the PATROL Agent, PATROL Console, and configuration utility is
started without a port number option, each service checksthe /etc/services
fileto seeif aport number is assigned. If a port number definition is
found, the service will use that port number. Otherwise, it will use the
default port number (3181 for the PATROL Agent, and random for
console and configuration utility.

If port contention is a problem, there is no standard way to find out what

process has a port locked. The netstat utility does not show which
application is actually using the port.
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Troubleshooting

This chapter describes some of the error messages you might encounter
while installing PATROL products and suggests ways of resolving the
problems.

Error MessagesforWindows. . ......... .. ..o i, C-2
Error Messages for Unix
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Error Messages for Windows

Problem:

Solution:

Problem:

Error Message:

Probable Cause:

Solution:

This section contains information about specific problems or error
messages that you might encounter while installing or configuring
PATROL in Windows environments.

PATROL Agent service failsto run.

Start the agent interactively in debug mode. This action will cause the
agent to display an error message. From acommand line, type the
following command:

c:\PatrolAgent

This command will not work unless the user account is set up properly.
See “ Setting Up An Installation Account” on page 1-12.

Commands fail to execute.
ExecuteCommand: Couldn't execute command of type 'TY PE'

The PATROL default account does not have the necessary rights to
execute the command.

Perform the following steps.

1. Make surethe PATROL default account is not locked out.

2. Make sure the cmd.exe file islocated in the winnt\system32 directory.

3. If alocal PATROL default account with the same name as adomain
PATROL default account exists on the server where the agent is

installed, select which account you want to use then delete the other
account.
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4. If you are using adomain PATROL default account, make sure the
account islisted in the local Administrators group (and is listed
separately) and has all seven of the following Advanced User Rights
on theloca computer.

— Act aspart of OS

— Debug programs

— Increase quotas

— Logonasaservice

— Logonlocaly

— Profile system performance
— Replace aprocess level token

5. Using the PATROL default account, log onto the server that has the
PATROL agent installed and stop the Patrol Agent service.

6. Check the PATROL_ADMIN environment variable to make sure the
correct PATROL default account islisted. If the correct account is
not listed, change the variable to the reflect the correct PATROL
default account.

Note
If the PATROL default account is a domain account, then the domain
name should be entered in front of the PATROL account name in the
PATROL_ADMIN environment variable. For example, DOMAIN\patrol.

7. Update the PATROL Agent configuration to reflect the correct
PATROL default account as follows:

A. Click Start => Programs=>BMC PATROL => Agent Configureto
start the PATROL Agent Configuration utility.

B. Inthe PATROL Agent Configuration dialog box, enter the
PATROL default account in the User Namefield.

C. Enter the password for the PATROL default account and click
OK.

8. Start the PatrolAgent service.
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9. Verify that the PATROL default account was updated in the agent
configuration by performing the following steps:

A. Onacomputer running a PATROL Console, in the
% PATROL_HOME%\bin directory, double-click wpconfig.exe to
start the wpconfig configuration tool.

B. Click Tools=> Get Configuration.

C. Inthe Get Configuration dialog box, enter the name of the host
where the agent is running and agent port number and click OK.

D. Intheleft tree view, select AgentSetup.

E. Inthelist of variablesin the right pane, verify that the account
displayed in the Current column for the defaultAccount variable
is the same account that you entered in the PATROL Agent
Configuration utility.

If the account is not the same, perform the following additional
steps.

A. Double-click defaultAccount.

A. Inthe Modify Variable dialog box, double click the account
entry under Changing Entries.

B. Inthe Set Default Account dialog box, enter the correct
PATROL default account name and password.

C. Click OK to close the Set Default Account and Modify
Variables dialog boxes.

Note

If the account you are entering for the defaultAccount variableisa
domain PATROL default account, make sure that you enter the domain
name and the account name; for example,

DOMAINNAM E\domainpatrolaccount (DOMAINNAME must be
uppercase).
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D. Click Tools=> Apply Configuration to apply the new account
and password configuration to the host.

E. Stop and restart the Patrol Agent service.

10. If you changed the PATROL_ADMIN environment variable, reboot
the server so the change will take effect.

Problem: Unable to log on.
Error Message:  Logon failure: unknown user name or bad password
Probable Cause: The PATROL Agent account does not have sufficient privileges.
Solution: Perform the following steps.
1. Make sure the PATROL default account is not locked out.
2. Make sure the cmd.exe file islocated in the winnt\system32 directory.

3. If alocal PATROL default account with the same name as a domain
PATROL default account exists on the server where the agent is
installed, select which account you want to use then delete the other
account.

4. If you are using adomain PATROL default account, make sure the
account islisted in the local Administrators group (and is listed
separately) and has all seven of the following Advanced User Rights
on theloca computer.

— Act aspart of OS

— Debug programs

— Increase quotas

— Logonasaservice

— Logonlocaly

— Profile system performance
— Replace aprocess level token
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5. Using the PATROL default account, log onto the server that has the
PATROL agent installed and stop the Patrol Agent service.

6. Check the PATROL_ADMIN environment variable to make sure the
correct PATROL default account islisted. If the correct account is
not listed, change the variable to the reflect the correct PATROL
default account.

Note

If the PATROL default account is a domain account, then the domain
name should be entered in front of the PATROL account namein the
PATROL_ADMIN environment variable. For example, DOMAIN\patrol.

7. Update the PATROL Agent configuration to reflect the correct
PATROL default account as follows:

A. Click Start => Programs=>BMC PATROL => Agent Configureto
start the PATROL Agent Configuration utility.

B. Inthe PATROL Agent Configuration dialog box, enter the
PATROL default account in the User Name field.

C. Enter the password for the PATROL default account and click
OK.

8. Start the Patrol Agent service.

9. Verify that the PATROL default account was updated in the agent
configuration by performing the following steps:

A. Onacomputer running a PATROL Console, in the
% PATROL_HOME%\bin directory, double-click wpconfig.exe to
start the wpconfig configuration tool.

B. Click Tools=> Get Configuration.

C. Inthe Get Configuration dialog box, enter the name of the host
where the agent is running and agent port number and click OK.

D. Intheleft tree view, select AgentSetup.
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E. Inthelist of variablesin the right pane, verify that the account
displayed in the Current column for the defaultAccount variable
is the same account that you entered in the PATROL Agent
Configuration utility.

If the account is not the same, perform the following additional
steps.

A. Double-click defaultAccount.

A. Inthe Modify Variable dialog box, double click the account
entry under Changing Entries.

B. Inthe Set Default Account dialog box, enter the correct
PATROL default account name and password.

C. Click OK to close the Set Default Account and Modify
Variables dialog boxes.

Note
If the account you are entering for the defaultAccount variableisa
domain PATROL default account, make sure that you enter the domain
name and the account name; for example,
DOMAINNAM E\domainpatrolaccount (DOMAINNAME must be
uppercase).

D. Click Tools=> Apply Configuration to apply the new account
and password configuration to the host.

E. Stop and restart the Patrol Agent service.

10. If you changed the PATROL_ADMIN environment variable, reboot
the server so the change will take effect.
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Problem:
Error Message:
Probable Cause:

Solution:

Unable to create acommand shell for the system output task window.

Couldn't execute shell *_NtTask ' as system output interactive task

The PATROL Agent account isinvalid.

Perform the following steps.

1

2.

3.

Make sure the PATROL default account is not locked out.
Make sure the cmd.exe file is located in the winnt\system32 directory.

If alocal PATROL default account with the same name as adomain
PATROL default account exists on the server where the agent is
installed, select which account you want to use then delete the other
account.

If you are using adomain PATROL default account, make sure the
account islisted in the local Administrators group (and is listed
separately) and has all seven of the following Advanced User Rights
on theloca computer.

— Act aspart of OS

— Debug programs

— Increase quotas

— Logonasaservice

— Logonlocaly

— Profile system performance
— Replace a process leve token

Using the PATROL default account, log onto the server that has the
PATROL agent installed and stop the Patrol Agent service.
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6. Check the PATROL_ADMIN environment variable to make sure the
correct PATROL default account islisted. |f the correct account is
not listed, change the variable to the reflect the correct PATROL
default account.

Note
If the PATROL default account is a domain account, then the domain

name should be entered in front of the PATROL account name in the
PATROL_ADMIN environment variable. For example, DOMAIN\patral.

7. Update the PATROL Agent configuration to reflect the correct
PATROL default account as follows:

A. Click Start => Programs=>BMC PATROL => Agent Configureto
start the PATROL Agent Configuration utility.

B. Inthe PATROL Agent Configuration dialog box, enter the
PATROL default account in the User Name field.

C. Enter the password for the PATROL default account and click
OK.

8. Start the Patrol Agent service.

9. Verify that the PATROL default account was updated in the agent
configuration by performing the following steps:

A. Onacomputer running a PATROL Console, in the
% PATROL_HOM E%\bin directory, double-click wpconfig.exe to
start the wpconfig configuration tool.

B. Click Tools=> Get Configuration.

C. Inthe Get Configuration dialog box, enter the name of the host
where the agent is running and agent port number and click OK.

D. Intheleft tree view, select AgentSetup.
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E. Inthelist of variablesin the right pane, verify that the account
displayed in the Current column for the defaultAccount variable
is the same account that you entered in the PATROL Agent
Configuration utility.

If the account is not the same, perform the following additional
steps.

A. Double-click defaultAccount.

A. Inthe Modify Variable dialog box, double click the account
entry under Changing Entries.

B. Inthe Set Default Account dialog box, enter the correct
PATROL default account name and password.

C. Click OK to close the Set Default Account and Modify
Variables dialog boxes.

Note
If the account you are entering for the defaultAccount variableis a
domain PATROL default account, make sure that you enter the domain
name and the account name; for example,
DOMAINNAM E\domainpatrolaccount (DOMAINNAME must be
uppercase).

D. Click Tools=> Apply Configuration to apply the new account
and password configuration to the host.

E. Stop and restart the Patrol Agent service.

10. If you changed the PATROL_ADMIN environment variable, reboot
the server so the change will take effect.
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Problem:

Error Message:

Probable Cause:

Problem:

Error Message:

Probable Cause:

Problem:

Solution:

The agent will not start.

Sess |nit failed: err = -14/10048. Another agent is probably running on
the same port

Another PATROL Agent is already running on the same port, or you
attempted to restart the Agent too soon after terminating it. The agent
uses TCP ports for some of its communications, and due to the nature of
TCP ports, it may take up to 4 minutes after the agent is terminated
before al TCP ports are closed.

PATROL Knowledge Modules fail to load.

Bad PSL script for NAME command type 'TY PE’, commandClass
'CLASS

A writable temporary directory is not available. Large PSL scripts require
an intermediate temporary file which the agent creates in the directory
identified by one of the following environment variables: TMP, TEMP, or
PATROL_TEMP. Verify that at least one of these environment variables
exists and that the PATROL Agent account has write access to the
directory(ies) specified by the environment variable(s).

Theinstallation utility will fail if aproxy server is specified for internet
connections in a supported Web browser.

Remove the proxy server connection setting or bypassit by performing
the following task for your browser:

e Internet Explorer: In the browser window, select Tools=> Internet
Options=> Connectionstab => L AN Settings => Bypass proxy server
for local addresses.
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Problem:

Solution:

Problem:

Solution:

Problem:

Solution:

* Netscape: In the browser window, select Edit => Preferences =>
Advanced => Proxies => Manual Proxy Configuration => View and
enter your domain in the Exceptions field.

Theinstallation utility fails on computers running Microsoft Windows
Terminal Services.

Make sure afile called check.exe exists in the Windows\System32
directory. Theinstallation utility usesthisfileto install productsin a
Terminal Services environment. If the file does not exist, you will need to
copy it from another Terminal Services computer.

The following error messages are seen during a product installation:

javascript error - line 67, screen not defined
javascript error - line 145, setlnterval is not
def i ned.

You are using a version of Netscape that is not supported by the
installation utility. Use one of the following versions: 4.75, 4.76, 4.77, or
4.78.

Theinstallation utility Help does not display properly; for example, the
Contents, Index, and Search tabs are not displayed.

To properly display the Help

« the Web browser that you are using to run the installation utility must
be Java-enabled

e you must have a Javavirtual machine or Java Plug-in version 1.1.2 or
later installed
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» thejavad0,jar file must exist in your Netscape installation directory

If it does not exist, you will need to download and reinstall Netscape.

Problem: The installation fails with the following error message:
“Error: Failed to run script [C\Program"

Solution: Thereisadirectory or file called Program and Program Files in the same
target installation directory causing the installation to fail.

Perform one of the following tasks to resolve this issue:
e Delete the Program directory or file.

e Rename the Program directory or file, perform the installation, then
rename the directory or file back to its origina name.

e Install PATROL to adirectory that does not have a Program directory
or file.

*  When you specify the destination path to install PATROL, use the

short name such as C:\progra~1\bmcsof~1\patrol~1 instead of using
C:\Program Files\BM C Softwar e\Patr ol 3.
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Error Messages for Unix

Problem:

Cause:

Solution:

Message:

Cause 1:

Solution:

Cause 2:

Solution:

This section contains information about specific problems or error
messages that you might encounter while installing or configuring
PATROL in Unix environments.

No error message is printed. You cannot correct typing errorsin
installation utility windows when using an X-emulator on a PC to run the
installation utility.

This can be caused by some X emulation software.

Usually one of these three controls will delete typed characters:
Backspace, Delete, or Ctrl+H.

Can’t Open Display

Your machine does not have permission to open the requested X 11
display.

Type the following command in the OS login window to permit
displays on your terminal:
xhost +your-hostname

Your DISPLAY environment variableis not set or isimproperly set.

For csh users, set your display variable to point to the DISPLAY
terminal by typing the following command:
setenv DISPLAY myworkstation:0.0

For sh users, set your display variable by typing the following
command:
DI SPLAY =mywor kstation:0.0; export DISPLAY
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Message:

Cause:

Solution:

Message:

Cause:

Solution:

For ksh users, set your display variable by typing the following
command:
export DISPL AY =myhostname: 0.0

Patrol Agent-F-EUSER:Patrol Agent -- not superuser

The PATROL configuration script was unable to set the ownership
and permissions of the PATROL and PATROL Agent executable
files.

Run the configure.sh script as described in “Running the
Configuration Script on a Unix Computer” on page 4-4. Thefile
attributes should be as follows:

(rwsr-sr-x) (root) Patrol Agent

Patrol Agent-F-EUSER: The variable PATROL_HOME is not set and
$HOME is not set

The environment variable PATROL_HOME is not set. The PATROL
Console and PATROL Agent use the path stored in thisvariable to
locate required files and utilities.

BMC Software recommends you always use the PATROL Console
startup script (that is, Patrol) or the PATROL Agent startup script
(that is, PatrolAgent) in the PATROL installation directory to start the
corresponding process. Either script setsthe PATROL_HOME
variable correctly.

If you are a csh user, however, and want to set the PATROL_HOME
environment variable manually, do so by changing (cd) to the
installation directory and entering the following command:

source ./.patrolrc
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For sh or ksh users, set the PATROL_HOME variable by changing
(cd) to the installation directory and entering the following

command:
. /patrolrc.sh
Problem: No error message is printed. PATROL seems to hang when it is started in
the background.
Cause: $PATROL_CACHE ison an NFS mounted system and NFS is having
intermittent network problems.
Solution: Move $PATROL_CACHE to alocal file system.
Problem: Open Look Window Manager does not respond to mouse movement and

“freezes’ the screen while running PATROL

Cause: Your management SPARCstation has two or more swap partitions,
and nat al the partitions are of the same size.

Solution: You may reconfigure your swap partitions and restart XNeWs.
Problem: The Motif Window Manager raises a window when clicked anywhere in
the window.
Cause: Motif Window Manager has inappropriate settings for PATROL.
Solution: Add the following two lines to your .Xdefaults file:

Mwm*keyboar dFocusPolicy: pointer
Mwm*focusAutoRaise: False

Run the following command:
xrdb -merge .Xdefaults
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Message: Commands fail with the error “Permission denied” because the agent
tried to execute them in adirectory the user doesn’'t have access to and in
which they don’'t even exist!

Cause: The version of csh distributed with HP-UX mistakenly searches the
command search ($PATH) path for programs to be executed. If the
PATROL Agent search path at startup contains directories that the
user does not have permission to access, the csh search terminates at
the first such directory encountered. The terminated search reports
that the command isin that directory but cannot be executed because
of insufficient privileges.

Solution: Start the agent with a minimal PATH that contains only
world-readable directories or directories that all PATROL users can
access. Make sure that $SPATROL_HOM E/bin isthe first entry in the
path, so that no path prior to SPATROL_HOME can cause a
PATROL command to fail.

For csh users, the following example shows how the setenv command
is used to specify the $PATROL_HOME directory as the first
directory in the search path:

setenv PATH $PATROL_HOME/bin: $PATH

/usr/local/bin:/bin:\

lusr/bin:/etc:/usr/etc

For sh or ksh users, the foll owing exampl e shows how the export
command is used to specify the SPATROL_HOME directory asthe
first directory in the search path:
PATH=${PATROL_HOMEJ}/bin:$PATH

export PATH

If you are still having problems, please contact a PATROL product
support representative,
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Problem:

Solution:

The PATROL directory tree islocated on an NFS-mounted file system
and errors are encountered with PATROL Agent initialization concerning
file permissions.

Create three new directories on alocal writable file system, and set
environmental variablesto point to them. For example:

cd /usr/local

mkdir patrol

cd patrol

mkdir history config log

The directories should be owned and writable by the default PATROL
account, which isusually patrol, or the account defined in
PATROL_ADMIN, which isalso usualy patrol. You can make this
change with the xpconfig utility.

In csh, the following commands set the environmental variables:

setenv PATROL _HISTORY /usr/local/patrol/history
setenv PATROL _CONFI G /usr/local/patrol/config
setenv PATROL _L OG /usr/local/patrol/log

In sh, the following commands set the environmental variables:

PATROL_HISTORY=/usr/local/patrol/history
export PATROL_HISTORY

PATROL _CONFIG=/usr/local/patrol/config
export PATROL_CONFIG

PATROL L OG=/usr/local/patrol/log

export PATROL_LOG

The environment commands may be placed in the .patrolrc file (for csh)
or patrolrc.sh file (for sh or ksh).
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Problem:

Solution:

Problem:

Solution:

Problem:

Solution:

Theinstallation utility will fail if aproxy server is specified for internet
connections in a supported Web browser.

Remove the proxy server connection setting or bypassit by performing
the following task for your browser:

e Internet Explorer: In the browser window, select Tools=> Internet
Options=> Connectionstab => L AN Settings => Bypass proxy server
for local addresses.

« Netscape: In the browser window, select Edit => Preferences =>
Advanced => Proxies => Manual Proxy Configuration => View and
enter your domain in the Exceptions field.

The following error messages are seen during a product installation:

javascript error - line 67, screen not defined
javacript error - line 145, setlinterval is not
def i ned.

You are using a version of Netscape that is not supported by the
installation utility. Use one of the following versions: 4.75, 4.76, 4.77, or
4.78.

Theinstallation utility may encounter problems such as not being ableto
access the root account during installation.

If you are using aKorn shell or C shell to perform the installation, switch
to aBourne shell. The preferred login shell isaBourne shell. A Korn
shell or aC shell is acceptable, but they may cause problems during the
installation.
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Problem:

Solution:

Problem:

Theinstallation utility online Help does not display properly; for

example, the Contents, Index, and Search tabs are not displayed.

To properly display the Help

the Web browser that you are using to run the installation utility must
be Java-enabled

you must have a Java virtual machine or Java Plug-in version 1.1.2 or
later installed

the javad0,jar file must exist in your Netscape installation directory
If it does not exist, you will need to download and reinstall Netscape.

the variable MOZILLA HOME should be set to point to the root of
the Netscape installation directory

Example

For sh or ksh users, if the Netscape installation directory is /opt/netscape,
enter the following commands to set this variable:

MOZILLA_HOM E=/opt/netscape
export MOZILLA_HOME

Example

For csh users, if the Netscape installation directory is /opt/netscape, enter
the following command to set this variable:

setenv MOZILLA_HOME /opt/netscape

After installing the PATROL for Unix KM version 8.3.06, the

Health-at-a-glance and SNM PHealth icons are missing on the PATROL
Console for Unix.
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Solution: To resolve thisissue, select the Custom installation type and the Console
Systems role when you install the PATROL for Unix KM from the
PATROL Solutions for Unix product CD.

Problem: After performing an over-the-top installation of the PATROL Agent or
PATROL Console for Unix 3.5 that uses PATROL for Unix 8.3.07, the
agent fails to start and the following error message is displayed:

error:unable to get stat of
/etc/patrol.d/security policy/site.plc, errno 2

Solution: PATROL Security component files are missing under
letc/patrol.d/security_policy, because the installation utility was unable to
access the root account during the product installation.

To resolve thisissue, perform the following steps:

1. Download the sec_configure P1202.tar patch from the BMC Software
ftp site at the following URL :
ftp://ftp.bmc.com/pub/patrol/patches/P_SECURITY/3.5/Unix/1.2.02

2. Follow theinstructions for installing the patch in the
sec_configure_P1202.readmefile.

Note
Before you apply the patch file, you must have previously installed either
the PATROL Console for Unix or the PATROL Agent version 3.5.
Execution of the patch requires security script files that are included
during the installation of either of these components.

3. Runthefollowing scripts as root to perform post-installation product
configuration to set permissions and links:

e configuresh, found in the BMCINSTBASE directory
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Problem:

Solution:

e bilconfig.sh, found in the BM CINSTBA SE/Patrol 35 directory

Note

If you enter the root password during the installation, the post-installation
product configuration will be performed automatically. In this case, you
will not need to run these configuration scripts.

The install ation shows a failure even though the correct directories and
fileswerelaid down. The following error message is displayed on the last
window of theingtalation utility:

FAI LED!
The follow ng products and conponents have NOT been
successfully installed on your nachine.

To review the details of the installation, click View
Log.

The root password was not supplied, so the installation utility was unable
to perform post-installation product configuration.

To resolve thisissue, perform the following steps:

1. Download the sec_configure _P1202.tar patch from the BMC Software
ftp site at the following URL :
ftp://ftp.bmc.com/pub/patrol/patches’P_SECURITY/3.5/Unix/1.2.02

2. Follow theinstructions for installing the patch in the
sec_configure_P1202.readmefile.
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Note
Before you apply the patch file, you must have previously installed either
the PATROL Console for Unix or the PATROL Agent version 3.5.
Execution of the patch requires security script files that are included
during the installation of either of these components.

3. Runthefollowing scripts as root to perform post-installation product
configuration to set permissions and links:

» configure.sh, found in the BM CINSTBASE directory
* bilconfig.sh, found in the BM CINSTBA SE/Patrol35 directory

Note
If you enter the root password during the installation, the post-installation

product configuration will be performed automatically. In this case, you
will not need to run these configuration scripts.
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.cshrcfile 1-16
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Jogin file 1-16
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custom event catalog, creating 5-14
Custom installation type, example of
product selection tree view 2-9
customer support iii
customization tips 4-9
customizations
how preserved during upgrade 5-2
to PSL code 5-13
customizing the PATROL Agent 5-11
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DEC UNIX
operating system tags required to create
an installable image using
-repository_oslist 3-27
versions supported by the installation
utility 1-4
default installation values 1-10
deploying created product images 2-16
destination IP address B-2
destination port B-2
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END USER LICENSE AGREEMENT
NOTICE

BY OPENING THE PACKAGE, INSTALLING, PRESSING “AGREE” OR “YES” OR USING THE PRODUCT, THE ENTITY OR
INDIVIDUAL ENTERING INTO THIS AGREEMENT AGREES TO BE BOUND BY THE FOLLOWING TERMS. IF YOU DO NOT
AGREE WITH ANY OF THESE TERMS, DO NOT INSTALL OR USE THE PRODUCT, PROMPTLY RETURN THE PRODUCT TO
BMC OR YOUR BMC RESELLER, AND IF YOU ACQUIRED THE LICENSE WITHIN 30 DAYS OF THE DATE OF YOUR ORDER
CONTACT BMC OR YOUR BMC RESELLER FOR A REFUND OF LICENSE FEES PAID. IF YOU REJECT THIS AGREEMENT, YOU
WILL NOT ACQUIRE ANY LICENSE TO USE THE PRODUCT.

This Agreement (“Agreement”) is between the entity or individual entering into this Agreement (“You”) and BMC Software Distribution,
Inc., a Delaware corporation located at 2101 CityWest Blvd., Houston, Texas, 77042, USA or its affiliated local licensing entity (‘BMC").
“You” includes you and your Affiliates. “Affiliate” is defined as an entity which controls, is controlled by or shares common control with a
party. IF MORE THAN ONE LICENSE AGREEMENT COULD APPLY TO THE PRODUCT, THE FOLLOWING ORDER OF LICENSE
AGREEMENT PRECEDENCE APPLIES: (1) WEB BASED LICENSE AGREEMENT WITH BMC, (2) WRITTEN LICENSE
AGREEMENT WITH BMC, (3) SHRINK-WRAP LICENSE AGREEMENT WITH BMC PROVIDED WITH THE PRODUCT, AND (4)THIS
ELECTRONIC LICENSE AGREEMENT WITH BMC. In addition to the restrictions imposed under this Agreement, any other usage
restrictions contained in the Product installation instructions or release notes shall apply to Your use of the Product.

PRODUCT AND CAPACITY. “Software” means the object code version of the computer programs provided, via delivery or electronic
transmission, to You. Software includes computer files, enhancements, maintenance modifications, upgrades, updates, bug fixes, and
error corrections.

“Documentation” means all written or graphical material provided by BMC in any medium, including any technical specifications,
relating to the functionality or operation of the Software.

“Product” means the Software and Documentation.

“License Capacity” means the licensed capacity for the Software with the pricing and other license defining terms, including capacity
restrictions, such as tier limit, total allowed users, gigabyte limit, quantity of Software, and/or other capacity limitations regarding the
Software. For licenses based on the power of a computer, You agree to use BMC'’s current computer classification scheme, which is
available at http://www.bmc.com or can be provided to You upon request.

ACCEPTANCE. The Product is deemed accepted by You, on the date that You received the Product from BMC.

LICENSE. Subject to the terms of this Agreement, as well as Your payment of applicable fees, BMC grants You a non-exclusive,
non-transferable, perpetual (unless a term license is provided on an order) license for each copy of the Software, up to the License
Capacity, to do the following:

(a) install the Software on Your owned or leased hardware located at a facility owned or controlled by You in the country where You
acquired the license;

(b) operate the Software solely for processing Your own data in Your business operations; and

(c) make one copy of the Software for backup and archival purposes only (collectively a “License”).

If the Software is designed by BMC to permit you to modify such Software, then you agree to only use such modifications or new
software programs for Your internal purposes or otherwise consistent with the License. BMC grants You a license to use the
Documentation solely for Your internal use in Your operations.

LICENSE UPGRADES. You may expand the scope of the License Capacity only pursuant to a separate agreement with BMC for such
expanded usage and Your payment of applicable fees. There is no additional warranty period or free support period for license
upgrades.

RESTRICTIONS: You agree to NOT:

(a) disassemble, reverse engineer, decompile or otherwise attempt to derive any Software from executable code;

(b) distribute or provide the Software to any third party (including without limitation, use in a service bureau, outsourcing environment,
or processing the data of third parties, or for rental, lease, or sublicense); or

(c) provide a third party with the results of any functional evaluation or benchmarking or performance tests, without BMC'’s prior written
approval, unless prohibited by local law.



TRIAL LICENSE. If, as part of the ordering process, the Product is provided on a trial basis, then these terms apply: (i) this license
consists solely of a non-exclusive, non-transferable evaluation license to operate the Software for the period of time specified from BMC
or, if not specified, a 30 day time period (“ Trial Period”) only for evaluating whether You desire to acquire a capacity-based license to
the Product for a fee; and (ii) Your use of the Product is on an AS IS basis without any warranty, and BMC, ITS AFFILIATES AND
RESELLERS, AND LICENSORS DISCLAIM ANY AND ALL WARRANTIES (INCLUDING, WITHOUT LIMITATION, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT) AND HAVE NO
LIABILITY WHATSOEVER RESULTING FROM THE USE OF THIS PRODUCT UNDER THIS TRIAL LICENSE (“Trial License”).
BMC may terminate for its convenience a Trial License upon notice to You. When the Trial Period ends, Your right to use this Product
automatically expires. If You want to continue Your use of the Product beyond the Trial Period, contact BMC to acquire a
capacity-based license to the Product for a fee.

TERMINATION. This Agreement shall immediately terminate if You breach any of its terms. Upon termination, for any reason, You must
uninstall the Software, and either certify the destruction of the Product or return it to BMC.

OWNERSHIP OF THE PRODUCT. BMC or its Affiliates or licensors retain all right, title and interest to and in the BMC Product and all
intellectual property, informational, industrial property and proprietary rights therein. BMC neither grants nor otherwise transfers any
rights of ownership in the BMC Product to You. Products are protected by applicable copyright, trade secret, and industrial and
intellectual property laws. BMC reserves any rights not expressly granted to You herein.

CONFIDENTIAL AND PROPRIETARY INFORMATION. The Products are and contain valuable confidential information of BMC
(“Confidential Information”). Confidential Information means non-public technical and non-technical information relating to the
Products and Support, including, without limitation, trade secret and proprietary information, and the structure and organization of the
Software. You may not disclose the Confidential Information to third parties. You agree to use all reasonable efforts to prevent the
unauthorized use, copying, publication or dissemination of the Product.

WARRANTY. Except for a Trial License, BMC warrants that the Software will perform in substantial accordance with the Documentation
for a period of one year from the date of the order. This warranty shall not apply to any problems caused by software or hardware not
supplied by BMC or to any misuse of the Software.

EXCLUSIVE REMEDY. BMC's entire liability, and Your exclusive remedy, for any defect in the Software during the warranty period or
breach of the warranty above shall be limited to the following: BMC shall use reasonable efforts to remedy defects covered by the
warranty or replace the defective Software within a reasonable period of time, or if BMC cannot remedy or replace such defective copy
of the Software, then BMC shall refund the amount paid by You for the License for that Software. BMC's obligations in this section are
conditioned upon Your providing BMC prompt access to the affected Software and full cooperation in resolving the claim.

DISCLAIMER. EXCEPT FOR THE EXPRESS WARRANTIES ABOVE, THE PRODUCT IS PROVIDED “AS IS’ BMC, ITS
AFFILIATES AND LICENSORS SPECIFICALLY DISCLAIM ALL OTHER WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT. BMC
DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE, OR THAT
ALL DEFECTS CAN BE CORRECTED.

DISCLAIMER OF DAMAGES. IN NO EVENT IS BMC, ITS AFFILIATES OR LICENSORS LIABLE FOR ANY SPECIAL, INDIRECT,
INCIDENTAL, PUNITIVE OR CONSEQUENTIAL DAMAGES RELATING TO OR ARISING OUT OF THIS AGREEMENT, SUPPORT,
AND/OR THE PRODUCT (INCLUDING, WITHOUT LIMITATION, LOST PROFITS, LOST COMPUTER USAGE TIME, AND DAMAGE
OR LOSS OF USE OF DATA), EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND IRRESPECTIVE OF ANY
NEGLIGENCE OF BMC OR WHETHER SUCH DAMAGES RESULT FROM A CLAIM ARISING UNDER TORT OR CONTRACT
LAW.

LIMITS ON LIABILITY. BMC'S AGGREGATE LIABILITY FOR DAMAGES IS LIMITED TO THE AMOUNT PAID BY YOU FOR THE
LICENSE TO THE PRODUCT.

SUPPORT. If Your order includes support for the Software, then BMC agrees to provide support (24 hours a day/7 days a week)
(“Support”). You will be automatically re-enrolled in Support on an annual basis unless BMC receives notice of termination from You
as provided below. There is a free support period during the one year warranty period.

(a) Support Terms. BMC agrees to make commercially reasonable efforts to provide the following Support: (i) For malfunctions of
supported versions of the Software, BMC provides bug fixes, patches or workarounds in order to cause that copy of the Software to
operate in substantial conformity with its then-current operating specifications; and (ii) BMC provides new releases or versions, so long
as such new releases or versions are furnished by BMC to all other enrolled Support customers without additional charge. BMC may
refuse to provide Support for any versions or releases of the Software other than the most recent version or release of such Software
made available by BMC. Either party may terminate Your enrollment in Support upon providing notice to the other at least 30 days prior
to the next applicable Support anniversary date. If You re-enroll in Support, BMC may charge You a reinstatement fee of 1.5 times what
You would have paid if You were enrolled in Support during that time period.

(b) Fees. The annual fee for Support is 20% of the Software’s list price less the applicable discount or a flat capacity based annual fee.
BMC may change its prices for the Software and/or Support upon at least 30 days notice prior to Your support anniversary date.



VERIFICATION. If requested by BMC, You agree to deliver to BMC periodic written reports, whether generated manually or
electronically, detailing Your use of the Software in accordance with this Agreement, including, without limitation, the License Capacity.
BMC may, at its expense, perform an audit, at your facilities, of Your use of the Software to confirm Your compliance with the
Agreement. If an audit reveals that You have underpaid fees, You agree to pay such underpaid fees. If the underpaid fees exceed 5% of
the fees paid, then You agree to also pay BMC's reasonable costs of conducting the audit.

EXPORT CONTROLS. You agree not to import, export, re-export, or transfer, directly or indirectly, any part of the Product or any
underlying information or technology except in full compliance with all United States, foreign and other applicable laws and regulations.

GOVERNING LAW. This Agreement is governed by the substantive laws in force, without regard to conflict of laws principles: (a) in the
State of New York, if you acquired the License in the United States, Puerto Rico, or any country in Central or South America; (b) in the
Province of Ontario, if you acquired the License in Canada (subsections (a) and (b) collectively referred to as the “ Americas Region”);
(c) in Singapore, if you acquired the License in Japan, South Korea, Peoples Republic of China, Special Administrative Region of Hong
Kong, Republic of China, Philippines, Indonesia, Malaysia, Singapore, India, Australia, New Zealand, or Thailand (collectively, “ Asia
Pacific Region”); or (d) in the Netherlands, if you acquired the License in any other country not described above. The United Nations
Convention on Contracts for the International Sale of Goods is specifically disclaimed in its entirety.

ARBITRATION. ANY DISPUTE BETWEEN YOU AND BMC ARISING OUT OF THIS AGREEMENT OR THE BREACH OR
ALLEGED BREACH, SHALL BE DETERMINED BY BINDING ARBITRATION CONDUCTED IN ENGLISH. IF THE DISPUTE IS
INITIATED IN THE AMERICAS REGION, THE ARBITRATION SHALL BE HELD IN NEW YORK, U.S.A., UNDER THE CURRENT
COMMERCIAL OR INTERNATIONAL, AS APPLICABLE, RULES OF THE AMERICAN ARBITRATION ASSOCIATION. IF THE
DISPUTE IS INITIATED IN A COUNTRY IN THE ASIA PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN SINGAPORE,
SINGAPORE UNDER THE CURRENT UNCITRAL ARBITRATION RULES. IF THE DISPUTE IS INITIATED IN A COUNTRY
OUTSIDE OF THE AMERICAS REGION OR ASIA PACIFIC REGION, THE ARBITRATION SHALL BE HELD IN AMSTERDAM,
NETHERLANDS UNDER THE CURRENT UNCITRAL ARBITRATION RULES. THE COSTS OF THE ARBITRATION SHALL BE
BORNE EQUALLY PENDING THE ARBITRATOR'S AWARD. THE AWARD RENDERED SHALL BE FINAL AND BINDING UPON
THE PARTIES AND SHALL NOT BE SUBJECT TO APPEAL TO ANY COURT, AND MAY BE ENFORCED IN ANY COURT OF
COMPETENT JURISDICTION. NOTHING IN THIS AGREEMENT SHALL BE DEEMED AS PREVENTING EITHER PARTY FROM
SEEKING INJUNCTIVE RELIEF FROM ANY COURT HAVING JURISDICTION OVER THE PARTIES AND THE SUBJECT MATTER
OF THE DISPUTE AS NECESSARY TO PROTECT EITHER PARTY’'S CONFIDENTIAL INFORMATION, OWNERSHIP, OR ANY
OTHER PROPRIETARY RIGHTS. ALL ARBITRATION PROCEEDINGS SHALL BE CONDUCTED IN CONFIDENCE, AND THE
PARTY PREVAILING IN ARBITRATION SHALL BE ENTITLED TO RECOVER ITS REASONABLE ATTORNEYS' FEES AND
NECESSARY COSTS INCURRED RELATED THERETO FROM THE OTHER PARTY.

U.S. GOVERNMENT RESTRICTED RIGHTS. The Software under this Agreement is “commercial computer software” as that term is
described in 48 C.FR. 252.227-7014(a)(1). If acquired by or on behalf of a civilian agency, the U.S. Government acquires this
commercial computer software and/or commercial computer software documentation subject to the terms of this Agreement as
specified in 48 C.F.R. 12.212 (Computer Software) and 12.211 (Technical Data) of the Federal Acquisition Regulations (“ FAR") and its
successors. If acquired by or on behalf of any agency within the Department of Defense (“DOD”), the U.S. Government acquires this
commercial computer software and/or commercial computer software documentation subject to the terms of this Agreement as
specified in 48 C.F.R. 227.7202 of the DOD FAR Supplement and its successors.

MISCELLANEOUS TERMS. You agree to pay BMC all amounts owed no later than 30 days from the date of the applicable invoice,
unless otherwise provided on the order for the License to the Products. You will pay, or reimburse BMC, for taxes of any kind, including
sales, use, duty, tariffs, customs, withholding, property, value-added (VAT), and other similar federal, state or local taxes (other than
taxes based on BMC's net income) imposed in connection with the Product and/or the Support. This Agreement constitutes the entire
agreement between You and BMC and supersedes any prior or contemporaneous negotiations or agreements, whether oral, written or
displayed electronically, concerning the Product and related subject matter. No modification or waiver of any provision hereof will be
effective unless made in a writing signed by both BMC and You. You may not assign or transfer this Agreement or a License to a third
party without BMC's prior written consent. Should any provision of this Agreement be invalid or unenforceable, the remainder of the
provisions will remain in effect. The parties have agreed that this Agreement and the documents related thereto be drawn up in the
English language. Les parties exigent que la présente convention ainsi que les documents qui s’y rattachent soient rédigés en anglais.
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